The Apple Macintosh Primer

William B. Sanders

The Apple Macintosh is considered state-of-art in computer architecture. Learn why in this fascinating book!
The Apple Macintosh Primer
The Apple Macintosh Primer

By William B. Sanders, Ph.D.

Illustrations generated by the Apple Macintosh on the Apple Imagewriter Printer

DATAMOST
The most out of our minds.
20660 Nordhoff Street, Chatsworth, CA 91311-6152 (818) 709-1202
Copyright © 1984 DATAMOST, Inc.
All Rights Reserved

This manual is published and copyrighted by DATAMOST, Inc. Copying, duplicating, selling or otherwise distributing this product is hereby expressly forbidden except by prior written consent of DATAMOST, Inc.

Macintosh™ is a trademark licensed to Apple Computer, Inc.

Apple® is a registered trademark of Apple Computer, Inc.

We would like to acknowledge Apple Computer, Inc. for its generous assistance in supplying DATAMOST with technical information about the Macintosh and providing the photographs used herein. However, Apple Computer, Inc. was not in any way involved in the actual writing of this book.
Writing a book about a new computer before its public release is doubly difficult. First, there is no bank of user information that has been accumulated. When I wrote The Elementary Apple and The Apple Almanac, I had the endless resources of Apple users, magazine articles and several books. With the Macintosh, there were no articles, user groups or books. Secondly, in writing a book on an unreleased computer, developers are sworn to secrecy. Therefore, there were few with whom I could discuss the various aspects of the computer.

Given the shroud under which the book was written, there would seem to be no one to acknowledge. However, I did receive a good deal of assistance from others who are with Apple, Inc. and other companies who are also developing software and hardware for the Macintosh. First, Guy Kawasaki of Apple, Inc. set me up with the necessary software and hardware for the Macintosh. In addition, Guy along with Cary Clark, also of Apple, Inc., answered the many questions I had about various aspects of the Macintosh. Pam Edstrom of Microsoft Corporation, Chris Morgan of Lotus Development Corporation, Barney Stone of DB Master Associates, Martin Alpert of Tecmar, Inc., Andrew Singer of Think Technology, and Lou Ryan of Living Videotext, Inc. gave me invaluable information on the software and hardware their respective companies are developing for the Macintosh. Katie Cadigan of Regis McKenna Public Relations supplied me with photographs for the book. To all of them I am most grateful.

The folks at DATAMOST, Inc. were most helpful, first in obtaining the permission to get the Macintosh and then in checking everything to make sure what was written in these pages had some resemblance to reality.

Finally, my wife Eli, sons Billy and David, and our dog Cassiopea (to whom I revealed everything) were patient as I labored on the “secret computer.”
## Table of Contents

**Preface** ........................................... 11

**Chapter 1: Overview of Mac** .............. 13

- Where You’re Coming From ....................... 13
- First Time Micro User/Owner .................... 13
  - GETTING Things FROM the Computer ........ 14
  - PUTTING Things INTO the Computer .......... 15
  - CHANGing Something in the Computer ....... 16
- Moving Up From Apple II, II+, //e or Apple /// ..... 17
  - Apple Application Users ..................... 17
  - Apple Hobbyists ................................ 19
- Switching From Another Micro .................. 22
  - Keyboard ....................................... 22
  - Microprocessor ............................... 23
  - Storage Capacity ......................... 23
  - Included Extras ............................ 24
- What You Get ..................................... 25
- The Mac Concept: Desktop in Silicon .......... 25
- The Mouse that Roams ........................... 27
- Where’s the Color? ................................ 28
  - What You See is What You Get ............ 29
- Mac and Lisa .................................... 30
- Summary ......................................... 31

**Chapter 2: What Can You Do With The Mac?** 33

- What’s Your Application? ...................... 33
- Business Uses ................................... 33
  - How Does the Mac Fit in Business? ....... 35
  - Word Processing in Business .............. 35
  - Financial Calculations ..................... 36
  - Data Bases and Business ................... 37
Chapter 3: Cranking Up The Mac .... 55

Setting Up the Mac .......................... 55
Booting Your System ......................... 56
The Menus .................................... 59
  Apple Icon Menu .......................... 59
  File Menu ................................. 61
  Edit Menu ................................ 62
  View Menu ................................ 63
  Special Menu .............................. 63
Mousing Around ............................... 64
  Dragging with the Mouse ................ 64
  Duplicating Folders ...................... 64
  Taking Out the Trash .................... 65
  Write-Protecting Your Disk .............. 66
  Folders Within Folders .................. 67
Window Dressing ............................. 69
  Scrolling Windows ....................... 69
Disk Work .................................... 69
  Saving Files to Work Disks .............. 70
Summary ..................................... 71
Chapter 4: Keyboard-Mouse Connection ........................................... 73

The Keyboard Layout ................................................................. 73
  Lower Case and Bottom Symbol ........................................... 73
  Upper Case and Top Symbol .................................................. 74
  Option Keys .............................................................................. 74
  Shifted Option Keys .............................................................. 75
  Special Keys ............................................................................ 76
  Mouse-Key Connection ............................................................ 76
  For Old-timers ......................................................................... 77

Chapter 5: Graphics with MacPaint ...... 79

The Menus .................................................................................. 80
Paint and Erase ........................................................................... 81
  Undo ....................................................................................... 82
  Changing Brush Shapes and Patterns ..................................... 82
  Brush Mirrors .......................................................................... 83
Spray Can and Pencil ............................................................... 83
The Paint Can: Filling in an Area ............................................. 85
Making Your Own Pattern ......................................................... 85
Saving Pictures .......................................................................... 86
Retrieving Your Pictures .......................................................... 88
Getting in Shape ....................................................................... 88
Straight Lines and Line Widths ............................................... 89
Cut, Paste and Move: Lasso and Selection ............................... 90
  Lasso ..................................................................................... 90
  Copying and Inverting .......................................................... 91
  Select .................................................................................... 91
  Tracing Edges with Select ..................................................... 92
  Flipping Out ........................................................................... 92
  Drag, Copy, Stretch and Look Strange .................................... 94
Give Me a Hand ........................................................................ 95
Text ......................................................................................... 97
Summary ................................................................................... 98
Chapter 6: Word Processing with MacWrite

Getting Started .................................................. 101
MacWrite Menus .................................................. 101
Setting Up Your Format ........................................... 103
  Margin Settings .................................................. 103
  Tab Settings ...................................................... 104
  Decimal Tab ...................................................... 104
  Vertical Spacing and Text Alignment ....................... 105
Saving and Retrieving Your Text ............................. 106
  Save and Save As .................................................. 106
  Retrieving Text .................................................. 108
Editing With MacWrite ........................................... 109
  Editing Letters and Words ...................................... 109
  Change .......................................................... 110
  Find ............................................................ 111
  Block Editing: Cutting, Copying and Pasting ............... 112
Merging Text ....................................................... 112
Merging Text and Graphics ...................................... 114
Using Multiple Rulers ............................................. 114
Inserting Page Breaks ............................................ 116
Headers and Footers .............................................. 116
  Setting Top and Bottom Margins .............................. 116
  Placing The Page Number, Date and Time ................. 117
Summary .......................................................... 117
Preface

When Apple Computer, Inc. first introduced their popular Apple II computer in the late 1970s the first consumers of those wonderful machines were basically "hobbists." This hearty group of microcomputer pioneers were interested in writing their own software, enhancing the basic machine with hardware and programs of their own making and generally having a whale of a time playing with their own computers. As microcomputers in businesses, schools and the home caught on with a larger segment of the population, fewer people wanted to play with their computers and more wanted computers to do work for them. Tasks such as typing, accounting, inventory control and other text and numeric calculations and processing came to be taken over by the microcomputer. These tasks were done with less effort and more efficiency than older methods, and the microcomputer had found a niche with the application user who never cared about learning how to program.

As more and more application users began purchasing microcomputers, the demands in performance went up. Programs were supposed to be "user friendly" (that's computerese for "idiot proof") and do everything a mainframe (big computer) could. When the software and hardware failed to meet the increased expectations, there were the inevitable grumblings. In part, this was due to an over-sale of the micro by everyone from the enthusiastic hobbist (who understood the computer so completely just about anything was "user friendly") to sales personnel (who understood nothing but the dazzling demonstrations of programs they sold).

When Apple introduced the Lisa and popularized the icon menus and mouse-controlled software, the application user had found the "perfect" machine. The only problem was the price tag. Few could afford the Lisa.

Now there's the Macintosh, an inexpensive state-of-the-art microcomputer for the average application user. From the initial concept of the computer desktop to the fabulous (but
unseen) hardware, the Mac is truly the first major leap in low priced microcomputers since the Apple II. Having a 68000 microprocessor with 32 bit architecture (compared to the 8 bit 6502 on the Apple II), the Macintosh eclipses just about anything currently available in its price range.

The purpose of this book is twofold. On the one hand it is a "primer" in the true sense of the word. It helps owners of the Macintosh computer learn how to operate their computers and work with some basic application software used on the Macintosh, MacPaint and MacWrite. (MacPaint is a graphics program and MacWrite is a word processor.) On the other hand, this book describes the operation of the Macintosh to people who are trying to make up their minds about the kind of microcomputer to purchase. I've tried to explain how it is operated and what it can do. I hope this will serve as an evaluative tool for those of you still looking for a computer for your business, school or home uses.
Chapter 1

Overview of Mac

Introduction

We might as well get the nickname for Macintosh straight right off the bat. It's Mac. (That done, you're halfway to understanding everything about computers.) Depending on your background and orientation, the Mac will be very different things. If this is your first computer, then you really got a winner. If this is not your first computer, either your second (or third) Apple or your second computer and first Apple, you already know that Mac is something special. Finally, for those of you who do not own a Macintosh and are reading this book to learn something about it, I would recommend seeing one in real life. This book just tells you what it does and how to work it with certain applications. It's one of those machines you've got to see in action to believe. (The photographs in the book will give you an idea of how it might fit into your application environment, however.)

Where You're Coming From . . . .

Depending on your category of computer user, the following sections apply to you or someone else. Just jump to the section that describes you and carry on.

First Time Microcomputer User/Owner

If this is your first experience with a microcomputer, you chose an opportune time and machine to break new ground. There is nothing much about the Macintosh that is like other computers. It does not require that you learn about computers
in the traditional manner. That is, you do not have to learn
how to program or a complicated set of protocols for creating
and accessing files. Basically the way you work with Mac is to
put disk-based programs into the computer and, using the
mouse (the computer's steering wheel) and/or keyboard, tell it
to do various things. In a nutshell, all you do is one of the
following:

1. Get something FROM the computer.
2. Put something INTO the computer.
3. CHANGE something in the computer.

When you look at that list, you might be wondering what the
big fuss about microcomputers is if that's all you can do with
them. However, if I told you it could put an elephant into an
aspirin bottle, that might be worth examining. Well, that's
about what computers do relative to other storage and re-
trieval media. If you have a file cabinet in your room, look at its
size in comparison to a box of those little 3½ inch microfloppy
disks used to store information on a Mac. How many micro-
floppies do you think could fit into your room or office, and
how many file drawers could you get into the same space?
Obviously, it would be a lot easier and cheaper to store every-
thing you need on the disks.

All right, now that you know that big things can be stored in
small places, let's take a look at the three functions described
above relative to the Macintosh. In Chapter 3, we will be going
over the procedures for working with the mouse in detail. For
now, we will be discussing the operation of the mouse in
general terms to provide the proper context for understand-
ning the concept of the Macintosh computer.

GETTING Things FROM the Computer

To get something from the Macintosh, you point to what you
want with a little pointer and push a button. You will be shown
various little pictures call "icons," and by pointing to what you
want, your computer will get it for you. One click will “get,”
two clicks will “activate.” In some cases, you must hold the
button down while you pull the pointer down a list of choices.
Stopping at your selection and releasing the button will “open”
your choice. After you have finished using what you want, you
then put it away. This is done by pointing the arrow to a
message or icon for putting things away.

So what can you get from the Mac? Basically, you get either
information or graphics. You can get anything from your cus­
tomer inventory or sales contacts to your tax calculations.
(You can arrange your bubble gum card collection if you
want.) Sometimes you will get information that is a combina­
tion of text (written messages), numbers (usually calculations)
and pictures (charts, graphs, etc.). Of course, depending of
your needs you will be getting different things from your Mac.

One of the things you will be using a lot are programs for
creating things. For example, the word processing program,
MacWrite, is something you will be using a good deal. With it
you can create text and store it on the microfloppy disks.
You just point to MacWrite (there’s a picture of a hand writing
on paper with the message MACWRITE below it) and push a
button twice. Likewise, for graphics, spreadsheets or any­
things else on your microfloppy disk, you just point and push.

PUTTING Things INTO the Computer

You know you can take all kinds of things out of the computer,
but in order to take them out, you’ve got to get them in there
somehow. Some of the things you put into the computer are
simply programs on your disks. We mentioned MacWrite
above, and all you do to get it into the computer is to put the
disk with MacWrite on it into your Macintosh. More important­
ly, you will be creating things that go into your computer that
are stored on the microfloppy disk. Using programs such as
MacWrite and MacPaint, you can store information you have
created. For example, let's say you have a letter you want to
send to certain customers. Using MacWrite, you can write a
letter and store it on your disk. To create and store such a let-
ter you would do the following:

1. Open MacWrite with the pointer.
2. Write your letter just as you would on a typewriter.
3. Save the letter you wrote as a file on the disk by pointing
to the “SAVE” button when prompted to do so.

You can also enter other information that you can store, such
as financial figures, pictures you draw or anything else you
have created. (There are even computer games that will store
the highest score on disk.)

There's one catch to Mac and all other computers. Whatever
you create must be stored to disk before you turn your com-
puter off. With Mac, this is easy to remember, since each time
you create something, before you can leave, you are asked
whether you want to save it. If you do, you just point
to “save” and Mac asks you to name the document and then
puts it on the disk for you. We'll get into the details of all of this
later, but it's important to have some idea of how this is
done.

**CHANGing Something in the Computer**

Suppose your business keeps track of the prices of your inven-
tory on special records, and it is your responsibility to make
sure that all price changes are kept up to date. If you have your
records stored on a Mac microfloppy disk, you do not have to
start all over with your records. All you do is get your records
from disk, edit the list to reflect the changes, and then store it
back to the disk. The beauty of it lies in the simplicity. If you
want, you can save the updated records under a different file
name so that you have a record of both the old prices and the
updated prices. In my work as a college professor, I keep
updating examinations, syllabi and other documents that require only certain changes. Of course, you can completely change a file's contents and store it under the same file name. This gets rid of the old information on the disk and saves the new information. It is a way of saving space on your disk and getting rid of information you no longer need.

For you first-time microcomputer users/owners, you now have a rough idea of what you can do with a Mac. There's a lot more detail, but you now know the essential functions of the Macintosh. If you want a comparative view of the Mac and other microcomputers, read the next two sections. Otherwise, skip to the section, "What You Get."

Moving Up From Apple II, II+, //e or Apple ///

This is where I belong. My first computer was an Apple II+, and it's still going strong after what seems like a billion hours of use. However, there are plenty of different orientations for those of you coming up from other Apples. (If you have an Apple Lisa, see the last section of this chapter.) For application users, the transition to the Mac will be smooth and simple. On the other hand, for programmers and hobbyists, such as myself, the transition is a combination of agony and ecstasy. So let's take it one group at a time with the application users first.

Apple Application Users

The great thing about the Apple II series of computers is its flexibility and the amount of software available. I don't know if any other microcomputer has a larger library of software, both commercial and public domain, than the Apple II series. If you have a pile of software, files, data and what not for the Apple II or ///, you're going to find that it will not run on the Mac. The old 5¼ inch disk will not even fit into the 3½ inch drive.
The biggest problem is going to be converting all those files you’ve created on your Apple II or /// to the Mac. For example, I’ve stored the text for eleven books on Apple II disks from a word processor not available on the Mac (yet!), and I’m not about to re-enter all that information from the keyboard onto MacWrite or another word processor for the Mac. So I either keep the old Apple II+ around or I figure out a way to transfer all of that data to a Mac file. In the meantime, I start creating new files on the Mac.

If you have data bases full of information, several VisiCalc™ spreadsheets, or some other data bank, getting it to the Mac may take some doing. If you have been using CP/M software with a Z-80 card, it will be even more difficult, because at this time the Mac does not support CP/M nor are there any plans for adding Z-80 capabilities to the Mac.

If you have data stored in standard ASCII format, there may be some hope for transferring files. Send them over the modem. I have not tried this with the Mac since I do not have the Mac modem and communications program yet. However, I have transferred ASCII (standard text files) from Apples to other computers with different microprocessors and have had no problems. Therefore, I think it’s worth a try using the Mac.

Like the Apple II, we can expect all kinds of devices to be made by either Apple, Inc. or third party developers for the Mac to accomplish the transfer of files from the 6502 microprocessor based machines to the 68000 microprocessor based Macintosh. It would not surprise me if some enterprising soul is already working on software and hardware to accomplish this very feat. For the time being, though, think about ASCII transfers. By the way, for you VisiCalc™ users, converting DIF files to text files is not that difficult. See David Miller’s book Apple Files (Reston, 1983) for techniques to transform DIF files into ASCII files.
Now that you know something about possibly transferring your old Apple files to the Macintosh, let's see what's in store for you with the Mac. In the next chapter, we will discuss the various software and accessories for the Mac, but here, let's take a look at using the Mac with application software. First of all, you're going to have to get used to using the mouse. That will probably take you a whole hour! You will find the Mac to be far more "user friendly" than the Apple II or Apple ///. That's because you choose items as you would from your non-computer work area instead of from a computer format. (See the section below in this chapter, "The Mac Concept: Desktop in Silicon.") Apple Computer has provided third party developers with all the information required to use the mouse and the desktop environment concept, so you may see your favorite Apple II or /// software redesigned for the Mac using the mouse. With 128K of RAM and a 32 bit microprocessor, you will be able to do a lot more with less hassle. Also, you will find the smaller 3½ microfloppy disk holds more than the 5¼ disk; so there will be less disk swapping on the Mac than the Apple II or Apple ///.

Another feature of the Mac which application users will appreciate is its portability. It is not a portable in the same way as a Radio Shack TRS-80 Model 100, NEC, or workslate, but it is a lot easier to transport than the Apple or Apple ///. I took a Macintosh with me on an airplane, and in its carrying case it fit under the seat in front of me. (I wasn't about to let them store it below with the luggage!) Thus, if you have more than a single work station where you will be using the Mac, it plugs into a single outlet with no extra cable or paraphernalia, and you will find it easier to move around than the Apple II, II+, //e or ///.

Apple Hobbyists

Let's face it, they still call us hobbyists, "hackers," and frankly I don't give a darn. If staying up until 3 o'clock in the morning trying to figure out why a program that flicks a bit somewhere
in memory doesn't work the way you hoped is your idea of a
whale of a good time, then you belong in this category. I sup­
pose those of us who leave messages on modem bulletin
boards at the wee hours and bore everyone with our single-
minded discussion of computers also fall into this batch of
Apple users.

The first thing the hobbyist is going to wonder is “Where's the
lid, and how do I get inside?” or “What! No slots?” OK, the
Mac is not the Apple II or //e. In fact, it's closer to the Apple ///
in that the Mac has no slots. So let's see about those slots.
First, you've got 128K of RAM and 64K of ROM. So you don't
need the additional RAM since you have more on the Mac than
the 6502 on the Apple II series can handle at once anyway. Slot
0 on the Apple II/II + was used for the 16K card so it could
have 64K of RAM like the Apple //e. That's one slot you won't
miss. Since the Mac has a 7” screen which adjusts to fit your
type font, you won't need an 80 column card. The disk drive is
built in, and there's a port for the second disk drive, so that
takes care of slot 6. (Besides, you don't have to buy the disk
controller card.) The same is true for a printer port, and thus
we scratch slot 1. Your modem went into slots 2 or 3, and with a
modem port on the Mac, you don't need one of those slots.

OK, let's see, we've taken care of slots for five items: 16K card,
80 column card, disk drive, modem and the printer. That
leaves three slots the Apple II or //e has that the Mac does not.
What are some other cards that would typically go into these
slots? A clock card? Mac has a built-in clock. An RGB monitor
card? Mac has only a black-and-white display and you have a
monitor built in. (Let's face it, you don't get resolution like the
Mac on the best RGB monitor.) That leaves one slot, and what
goes in there? The Z-80 card that runs your beloved CP/M. The
trade-off is a 68000 microprocessor and the Mac operating
system for a Z-80 and CP/M.

All in all, you get so much with the Mac that you had to buy
separately for the Apple II and //e that you're not losing that
much anyway. Besides, you get the mouse, a four channel
sound connector and there are some smart people working on ways to expand the Mac already. Give it some time, and there will be as many devices to add to the Mac as the most slot-clogged Apple II.

The next big shock for previous Apple II and /// owners is the lack of a BASIC in ROM. With a 64K ROM, Apple Computer could have provided a BASIC that would knock your socks off. However, rather than sticking with one language, Apple filled that ROM with the operating system and the user interface toolbox (which includes the QuickDraw graphics package). Those ROM-based utilities can be accessed by almost any language. Apple Computer plans on releasing Macintosh Pascal first, and then a Macintosh BASIC. (They may already be available, depending on when you're reading this.) The general organization of the insides of Mac is geared toward Pascal, so you Pascal programmers will have trouble finding a more conducive programming environment. Also, Apple has a Mac-Assembler/Debugger in the works and a Macintosh Logo for the younger set.

If you're surprised by the choice of Pascal over BASIC for the primary language, you shouldn't be. Pascal is about as easy to learn as BASIC and is far more efficient. Pascal is more standardized and more transportable than BASIC as well. It requires (forces) better programming habits in the form of structured programming. So, it might be a good time to learn Pascal, but you can wait until the Macintosh BASIC is available if you're a staunch believer in BASIC.

Finally, for the Apple II hackers, we have to remember most people expect computers to do useful things. While it's fun to play with all of the intricacies of programming and tour the insides of your machine, computers are first and foremost tools. Thus, rather than starting off with programming languages, Mac starts with programs. There will be plenty of time to stay up until 3 a.m. hacking away on a program to make the output print upside down.
Switching from Another Micro

For those of you who are switching from non-Apple microcomputers to the Macintosh, the Mac is as different from the Apple II and Apple /// as it is from whatever you had before. File handling and disk access is done with the mouse, and other than word processing and numeric entries, so too are most other aspects of the computer.

To compare the Mac with some or all of the other micros on the market would be superfluous and time consuming. Rather, since I never met a microcomputer I didn't like, I will make some general comparisons that may or may not relate to your other computer. The following computers are the basis of comparison: Atari 400 and 800, IBM-PC and IBM-PCjr, Commodore 64 and VIC-20, Radio Shack Color Computer and Model 100, Texas Instruments 99/4A and the Timex/Sinclair 1000.

Keyboard

Many users like a keyboard with lots of special keys and function keys. Since the main usage of my computer is word processing, I prefer a cleaner keyboard with fewer keys to get in the way. However, if you like the convenience of single-strike function keys for programming or running applications, you'll not find too many such keys on the Mac. Rather, the graphic menus are set up to be accessed with the Macintosh mouse. There are special keys on the Mac that will be discussed in detail in Chapter 4, but instead of looking for specialized keys, look for similar functions in the mouse. You will also find that the function of a specialized key changes depending on the application. This is essentially the same thing as a function key used in different applications.

For those of you who have used membrane keyboards, this keyboard will be a true boon. Since it is relatively small and compact, it is simple to learn where everything is, and you can move it around to a comfortable position relative to your screen, as with the IBM-PC/PCjr keyboard.
Microprocessor

Probably the closest living relative to the 68000 on popular micros is the 16-bit 6809 on the Radio Shack Color Computer. (That’s right, gang, that little Color Computer had a 16-bit processor with an 8-bit data bus all this time!) Most of the other popular micros are either 6502 (6510 on the Commodore 64), Z-80 or 8088 based micros. None of the popular microcomputers have had true 16-bit operations since they have 8-bit data channels. (Some 16-bit operations are possible though.) However, the 68000 has 32-bit registers and a 16-bit data bus. That means it can handle more information in one gulp and do it faster than what you’re used to seeing.

Storage Capacity

The microcomputer standard has become 64K, but in the same way that the standard moved up from 4K to 16K and then to 48K, it looks like the newer standard is becoming 128K. Both the Enhanced PCjr and the Mac have 128K of RAM. This means that the newer computers can store more and run more sophisticated programs. A feature added to the Mac that you will appreciate but not see is the 64K ROM. In that ROM is the utility toolbox that is used by many of the application programs for the Macintosh. This will really save on the RAM space when you run applications. The trade-off is the lack of a programming language in ROM, but since the programming languages becoming available for the Mac can access routines in the ROM, it provides a good deal of flexibility. It also lets you work with a smaller language and do more.

The disk storage capacity on other popular micros ranges from 70K to 360K. The Mac microfloppies store 400K. This will cut down on the number of disks you have to buy and problems in locating your programs. If your other system had only a cassette-based mass storage system, you will really like the speed of using disks.
Included Extras

Most other micros require you to purchase certain essentials as extras. Very few other micros provide all the standard features of the Mac. Other than portables, such as the Radio Shack Model 100 and Kaypro, when you buy your computer, you do so one component at a time. On just about all micros, you have to purchase the monitor separately along with a mass storage system, either disk or tape. Likewise, many computers do not have built-in interfaces or connectors as does the Mac. This feature allows the Macintosh to be very compact and portable.
What You Get

Depending on where you have been reading above, you know more or less what comes with your Macintosh. To get everyone caught up, the standard, plain vanilla Macintosh comes with the following:

2. Keyboard and keyboard connecting cable.
3. Mouse with connecting cord.
5. A “Guided Tour” learning disk and cassette tape.
6. Two Apple decals.
7. A blank 3½ inch microfloppy disk.
8. A system diskette.
9. A power cord.

In the next chapter, we will discuss what other options are available for the Mac and others that are becoming available. For now, though, you know what you get when you get the Mac.

The Mac Concept: Desktop in Silicon

Most computers and their accompanying programs are set up in a computer environment. That is, when you look at a computer CRT screen, you see what looks like a menu screen. There may be menus of choices you can make, and you choose one of the choices by pressing a key. The screen then blanks out for a second as the program loads your choice. Usually, the options you have are in text and you hit a single key to make your choice. Some operating systems have separate areas for disk access and jumping from your program (either an application or one you are writing yourself) requires that you dump what you are working on. Once you get used to working in the computer environment, it is fairly simple to conceptualize your work in terms of the way the computer is set up.
Another way of approaching work with a computer was first developed by the Xerox PARC and then carried over to the Apple Lisa and Macintosh. Rather than beginning with a "computer environment," Apple began with a more familiar work area, the desktop. Imagine sitting at a work desk with no computer at all. What's going to be on the desk? There will probably be some pens and pencils and something on which to write, a note pad. There might be a typewriter. Over to the side there's likely to be a file cabinet with various files, reports and other written or printed material you use on occasion. You're likely to have a telephone and perhaps an intercom. Some graphics material for preparing presentations to illustrate certain aspects of your work may be in your office as well. Off to the side there's going to be a trash can — the famous "round file" to use for documents you no longer need or for burying mistakes.

Suppose you could recreate this desktop environment on a computer. Instead of having to learn how to work in a computer environment, you would be able to work in one you already know — one designed with the user in mind and not the limitations of a microcomputer. Essentially, that is what the Macintosh has done. When you want something on your desktop, instead of finding a menu and pushing a key, you "reach" for it or point to it with the mouse-run pointer. When you place the pointer on the item, you then click the mouse to indicate that's the item you want. By moving the mouse on the desktop, you simulate moving your hands and arms around a desk. However, it's even simpler than a real desk. When you want something from the filing cabinet, you don't have to get up and go rummaging through it. Instead, you just point to the file cabinet on your screen's desktop. Rearranging your desktop — or indeed your entire office — requires only moving things around on your screen desktop. You point to what you want moved and, holding down the button on the mouse, you "drag" it where you want. To select an item from the desktop, simply point to it and double click the mouse button. To "pull down" a menu, point to the menu and, while holding down the button, move the pointer to your selection. Release the button
to activate that selection. You might be working on your planning schedule, a report you’re writing, a list of club members, or a set of charts you’re making for a presentation to the sales staff. You can do all of this without once getting up from your desk.

If you are used to working in a computer environment, especially if you’re a programmer, but also if you’re an applications user, this may take some time to understand. However, if this is your first experience with a microcomputer, you will find it far more natural than going through the typical protocols of most other computers, which are necessary to find what you want. Once you understand the desktop concept, however, it makes a lot of sense and is very easy to use.

The Mouse that Roams

The mouse can be understood as either a replacement for special keys (or special uses of keys) or a way of “grabbing” things inside your computer and using them. For those of you who are accustomed to a computer environment, think of the mouse as a replacement for specialized cursor keys. Overall, however, it is best to think of it as an “arm” you can stick inside your computer to get what you want.

In addition to the use of the mouse within the concept of a computer desktop for pointing and grabbing, the pointer can also serve as an artist’s tool. From within MacPaint, the pointer becomes an artist’s brush, a drawing pencil or any number of other artistic/graphic devices. On other computers, everything from game paddles and joysticks to the keyboard have been used to create graphics. Rather than over-use the keyboard or draw with devices used for playing games, the mouse serves as a flexible alternative to more traditional peripheral devices.
Where's the Color?

One of the reasons I chose the Apple II over other microcomputers available at the time was the color graphics. Not only were games spectacular, but it was fun creating color graphics. As time went on, I found myself using a green screen monitor for most of my applications, and when I did do graphics, I rarely used color any more. One of the main reasons was that when I dumped my graphics to my printer, there were no colors. It's not impossible to create color graphics on a printer, but such printers were expensive and fuzzy. You had to get special ribbons or inks (for the ink jet printers) and you had to change them at strange intervals. Most of the time I was printing black text; I would have used up the black portion of the ribbon, or black ink, quicker than the others. Besides, most of my graphics were for an Apple User Group newsletter, and all of the printing was in black and white anyway. It's not that I still don't like color graphics, but rather, since I rarely play games any more, I just don't need or use them.
What You See is What You Get

A major feature of the Macintosh is "what you see is what you get." For those of you who have used word processors that change printer fonts with embedded codes or typed in text in 40 columns and printed it out in 80, you will have some appreciation of getting on your printer what you see on the screen. For example, on my printer, if I want a word italicized, I place an inverse "I" after the word to be italicized. On the screen, all I see is the word with an inverse "I" following it.

With the Mac, using the MacWrite word processor and the Imagewriter serial printer, whatever I print on the screen will print on the paper. Thus, if I use italicized printing in the word processor, then I will see the same italicized printing on the screen as I will on the paper. Likewise, I can control up to five font sizes, several styles and different fonts, seeing them on the screen in exactly the same way as they will appear when I print them. (See Chapter 6 for a further description of MacWrite's capabilities.) Thus, I can make the header for my document in one font size and style, have the text in another type size and style, all along seeing exactly what it will look like on paper when I dump it to the printer. (For newcomers to computers, the term "dump" means to "send" and has no connotation concerning the quality of the text being sent.) Since the screen is black and white, what I get is black and white.

Perhaps you might be thinking that colorful brochures or graphs would be nice, and if you had color graphics and a color printer, you could whip up a few thousand copies. For a megabuck computer and printer, that is probably true. However, for a computer in the Mac's price range and a printer that can do fast printing in color, you will find that even small color jobs are going to tie up your printer for a considerable time. So, if you have to have color graphics, and you want to use your computer as a printing press, then prepare to spend a lot
of money. The Mac is not for you. On the other hand, if you want flexibility, and you can get along fine with black and white text and graphics (512 by 342 pixels), then you can do well with the Mac and an Imagewriter printer.

Mac and Lisa

When the Apple Lisa first came out, it revolutionized thinking about what a desktop computer should do. The mouse, while originally used on a Xerox computer, never really caught on until Lisa re-introduced it. Then mice became available for other micros, and software took on many Lisa-like features. The idea of using "icons" (little graphic representations) instead of text caught on. This substitution of icons for text did not suggest mass illiteracy, but rather gave life to the notion of a desktop environment. The only problem with Lisa was the price tag of $10,000. That was a computer for either a very rich hacker or a company executive. Even when the price of Lisa came down to $7000, it was out of reach of the typical personal computer user.

Enter Mac at about a fifth of the original price of a Lisa, and suddenly this fantastic technology was within the grasp of the average personal computer user. To say that the Mac is the "little brother" of Lisa or a "Poor Person's Lisa" would be accurate. The same microprocessor, desktop analogy and mouse-controlled icon/menu system is used. The screen is smaller, and so is the memory, but otherwise it is very similar to a Lisa in concept and operation. Obviously, it cannot do as much as Lisa, but it's not supposed to. However, the fact that the two computers share the same microprocessor and design concepts will aid in cross-development of software for the two machines.
Summary

This first chapter tried to do a lot in a little space, but the main idea is to give the reader an overview from different perspectives. Looking back over it, it almost appears to be a sales pitch for the Mac. It's not meant to be, and at the same time, it is not a critical review. Rather, I have attempted to document what I found unique and important about the Mac. As I have said, I've never met a micro I did not like, but this one is really different in significant ways. For the first-time application user, it is probably the most user-friendly computer on the market as well as the easiest to learn. This is due to the desktop environment and mouse-controlled icons on the Macintosh. On the other hand, for owners of Apple II series computers or non-Apple micros, it is a wholly different kind of microcomputer. The discussion of Mac's lack of color graphics and expandability was not meant to be seen as an apology for anything lacking in the Mac. Rather, I tried to explain the logic of Mac in its own terms. It is a different computer, taking a sharp turn in the concept of what a personal computer should be and the manner in which it should be operated. My prejudice is that I happen to like the new concept.
Chapter 2

What Can You Do With the Mac?

What’s Your Application?

In the first chapter, we discussed a number of things one might do with the Macintosh, but we never really got into very many specifics. This chapter explores specific applications that users in different environments might have for the Mac and various hardware and software available or becoming available for the Mac. In part this is an answer to the practical questions of what you can do with a microcomputer. Oldtimers on microcomputers might shake their heads at the obvious utility of a computer, but newcomers want clear answers to practical questions. The big question centers around using a computer instead of a traditional method and using a Mac as opposed to some other system. As much as possible, I will attempt to integrate the answers to these questions into the text.

A special section is set aside for programmers. This will provide the technical information about the Mac along with the programming environment of the 68000 microprocessors and the 64K ROM in the Mac. As in the first chapter, you will probably want to skip those parts that do not coincide with your interests.

Business Uses

The design concept for the Macintosh is for use in small and medium sized businesses. Already, many such businesses have introduced microcomputers into the work environment
with mixed results. On the one hand, there have been many success stories of increased productivity, reduced operation costs and high efficiency. However, on the other hand, there are horror stories of having a roomful of expensive paperweights. Part of the problem lies in overblown sales pitches that claim far more than the computer can actually do. Business people are led to believe their microcomputers can perform the tasks of a mainframe (a big computer) and they are disappointed when a $2000 computer won't perform the same tasks as one costing $20,000 or $200,000.

A second problem is the use of the right software. Since many business people have little idea of what software they need, they often buy software that will not do what they need to have done. Also, they will often buy two different sets of software that are incompatible, such as a database program that cannot be used in conjunction with their word processing system or spreadsheet program.

Finally, many so-called “user-friendly” software packages are only user-friendly to computer scientists. When the hardware and software are demonstrated by the salesperson, it looks like a piece of cake; but when the office staff tries to get the thing going, the contraption goes nuts. Complaining buyers are made to feel like low-grade morons when another demonstration is whipped out. (The documentation was written by the same guy who wrote the instructions for assembling swing sets for kids.)

Obviously the solution to the problem of productive microcomputer use in a business environment is having realistic expectations of what a personal computer can do, getting the right software for the job and getting a computer and software that won't cost a fortune in staff training. The concept of “integrated software” is important here. If the files from one software package can be used with files from another package, it is “integrated.” Sometimes a single software package will have several programs working together. For example, a program called Lotus 1-2-3 integrates a spreadsheet, database
and graphics program into a single package. Other programs, even from different manufacturers, can also work together in an integrated manner. Not only does integrated software save time when it comes to putting files from different programs together, the procedures for operating integrated software are very similar in function. Therefore, if the staff learns how to use one part of a package, it is simple to learn how to use the other parts as well.

How Does the Mac Fit in Business?

So the question now becomes, how does the Macintosh fit into the business user's equation? Let's start with the operating system. As you already know from the desktop concept, the Mac was built with the end user in mind. That is, the design was built around the user, instead of demanding the user adapt to the computer. This should go a long way in solving the problem of training personnel to use the computer. (It also overcomes staff resistance to using computers in the first place.) The mouse-desktop combination goes a long way in simulating what the staff already does. Good software on any microcomputer will make learning its use simple, but the Macintosh is one of the few microcomputers that was designed internally that way.

Word Processing in Business

Secondly, what practical business applications are there with the Mac? First and foremost there is word processing. We've discussed MacWrite to some extent, and in Chapter 6 we will go into using that program in detail. For business applications, virtually all written communication can be handled on the Mac in a way that is more flexible, simpler and more practical than most dedicated word processors. For example, to set the tabs and margins on MacWrite, all the user does is to move the tab and margin settings in the same way you would with a normal typewriter. Using the pointer the user simply slides the
tab and margin indicators across a horizontal bar. As on most word processors, MacWrite makes multiple copies, editing and customizing communications a snap. Form letters can be created and used whenever the need arises. However, with the Mac, you can also change fonts, make your own letterheads and do all kinds of other things that other word processing systems can do only on a limited basis. It comes very close to being a typesetting machine that is as easy to use as a typewriter.

Financial Calculations

A second major use of microcomputers for businesses is financial calculations. There are so many different kinds of accounting that have to be performed in business that computers have become a near necessity. Most important for business users is

A spreadsheet program is only one of the many applications for the Apple Macintosh.
a spreadsheet program. These programs can handle several different kinds of calculations in a matrix of cells. The horizontal and vertical calculations are arranged so that, depending on the cell a figure occupies, it will be added, subtracted, multiplied or subjected to some other calculation appropriate to its function. For example, in setting up profit calculations, certain items have to be subtracted for costs and overhead and others added for receipts. In companies with several products, not only must the cost and profit of each item be weighed, different types of discounts must be considered as well. Using a spreadsheet program, all the user has to do is to set up the spreadsheet appropriate for the business, and then enter the figures in the appropriate cells. The computer does the rest. Not only does this provide a simple and accurate way of calculating profits and inventories, it can be used for projecting or modeling future plans. Further on in this chapter, we will look at some such programs for the Macintosh.

Data Bases and Business

A third major business application is in using database programs. These programs allow the user to enter information in terms of various fields and quickly retrieve that information by searching on any single field. You can think of a database program as a replacement for a file cabinet. For example, I once used a database program for a list of potential customers for soliciting advertising. Each record included the following fields:

- Business Name:
- Contact Name:
- Address:
- City:
- State:
- Zip Code:
- Phone Area Code:
- Phone Number:
- Product:
Sent sample (Y/N):
Contacted — Date (mm/dd):
Response — (Yes/No/Maybe):
Follow up — Date (mm/dd):
Contract (Yes/No/Pending):
Contract Date (mm/dd):
Date billed (mm/dd):
Date paid (mm/dd):
Notes:

Not only would the database program crank out a mailing list, I could find information about some or all of the people on the list. For example, after initial contacts, I wanted to follow up on those customers whose response to my initial inquiries was “Maybe.” To get to those customers, I simply had the database program search my list under the field name “Response” with an answer of “Maybe.” Rather than having to sort through a file cabinet by hand, my list was quickly searched by the database program, and the appropriate names were presented one at a time. In addition, mailing labels were made up for that group. Needless to say, this method took up a lot less room than a file full of names, was quicker and far more efficient than sorting through a lot of papers in folders.

Using the Mac for this type of work is very easy. Database lists are kept in file folders, and you just open a “folder” with the mouse and electronically pull out what you need. The database can be integrated with your word processor so that when your database accesses certain names, form letters can be created for each of the selected names along with mailing labels, bills, invoices or whatever else you may want to include. All of this is done in the little space taken up by the Mac on a 3½ inch microfloppy disk. (A box of microfloppies can hold close to what a five drawer file cabinet does.)

Business Communications

A fourth area where microcomputers are revolutionizing business is in communications. Combined with a telephone
modem and communications software, your Mac can send everything from inter-office memos to complete reports across the country. Suppose your business is in Dallas, Texas and your customer is in Fairbanks, Alaska. Your customer wants a full description of your product and has to make a buying decision tomorrow morning. (For some reason, your company does not have a representative in Fairbanks.) Under normal circumstances, you would either have to hop the first flight to Fairbanks and hand deliver the report to have even a chance of making the sale, but with a modem, you could send the report directly to the customer’s computer. Not only does this method save time, it saves money, and you know your document was received on time.

Business Graphics

A final area of business applications for the Mac we will discuss in some detail is business graphics. Anybody with experience in advertising will tell you a picture is worth a thousand words, and with the 512-pixel by 342-pixel graphic screen on the Macintosh, you can create very fine and clear graphics. When most business people think of computer graphics, charts and graphs come to mind. Bar, pie and line graphs can be created by just about any microcomputer using the right software. The Macintosh can do those easily and label the graphs with an assortment of fonts.

The real difference in the Macintosh is the high resolution graphics that can be stored on disk. The first time I saw the Macintosh, all the diagrams of the computer, including technical drawings of its system digital board, were done on the Mac. Obviously a black and white rendition of your product made on the Macintosh will not replace first-class photography or an artist’s drawing of your product. However, where graphics are required in reports or technical product descriptions, the graphic capabilities of the Mac are more than adequate. Since the graphics can be integrated into the word processor, it is simple to create reports with the appropriate graphics.
Other business uses depend on your particular type of business or more specific applications. Tasks such as project planning, concept organization, financial planning, market projection and other business-related work can be done either with general application software or specialized software. At this point you may consider hiring a consultant to set up your various applications and train your staff. For example, creating complicated spreadsheet templates is more difficult than using them once they have been created. A consultant can do in a few hours what might take several days for a business person to do. Once you become familiar with your software, you or your staff can do what the consultant did. However, if this is your first time using certain business applications, a good consultant can do a lot to get you started on the right foot.

Finally, you may want to consider customized software. This will cost you a good deal more than buying packaged software, but if you have a highly specialized business need, software manufacturers probably will not produce a package for such a limited market. A good consultant can tell you if packaged software can be configured to meet your needs and if it cannot be, he or she can recommend someone who writes customized software. Since Apple Computer has provided a good deal of information for software developers, you can have your customized software made to fit the Macintosh desktop concept.

School Uses

A second major area of application for the Macintosh is in the school. For the most part, this means use by college students for their various assignments. However, the Mac is not your basic "computer literacy" machine. Rather, the Mac is a general application computer that would best serve for college-level assignment completion.

Word Processing in School

The secret to good writing has always been good rewriting. Once a written assignment has been completed, there is little
incentive to go over the whole thing, make massive changes, and do it all again. It's hard enough to complete an assignment, but to rewrite it is doubly time-consuming. This is where word processors come in very handy. After completing a first draft, making changes, even moving entire sections from one place to another is quite simple.

To be sure, virtually any word processor can be used on any computer to make rewriting assignments less difficult. The Mac has four features that make it special:

1. **Seeing what will be printed.** This feature is important for stylistic editing. For example, words to be printed in **bold face** or **italicized** can be seen on the Mac screen in the same way as they will be printed to the paper.

2. **Graphic-text combination.** Having various graphs and charts in a paper is important for both appearances and summarizing information. Most personalized computers and software cannot integrate the two as can the Mac. Since MacPaint can combine both text and graphics, and MacPaint files can be integrated into MacWrite files, it is possible to have even complex statistical and mathematical formulas in your reports.

3. **Memory capacity.** Since each disk holds 400K, and the RAM has 128K, the Mac can handle larger word processing files than most other micros. Since word processing takes up a lot of memory, memory size becomes important in this area. The MacWrite program leaves about 30K for word processing files being created, allowing for a maximum of 8½ pages. Most other word processors and microcomputers do less and leave less space in RAM and on disk than the Mac.

4. **Compact size.** As a portable, the Mac is easily "totable." With only three main parts, the main unit, keyboard and mouse, the Mac can be taken away from home to college and to different usage sites on campus.
Apprenticeship in Applications

Word processing has applications in virtually every area in college, but other uses of a microcomputer depend on the major area of educational concentration. In math and science, the Macintosh can handle more sophisticated and larger formulas than smaller computers. Given the 68000 microprocessor, it can do calculations a good deal faster. In psychology and the social sciences, where large data bases are used with statistical tests, the larger RAM memory needed for "number crunching" allows microcomputer processing on what only a larger mainframe has been able to handle.

In the more applied areas of education, such as business, the Mac serves as a learning tool for working with applications later required in the work environment. Applied modeling is especially important because it allows students to experiment

The Apple Macintosh can be transported with ease.
with new structures and designs without bankrupting a company! Art and graphics, telecommunications and virtually every other area in which creative and analytical education is taking place can make use of the Mac in one way or another.

A final note concerning the use of Mac in a college environment is security. Use of computers in college dormitories, fraternity and sorority houses, and student apartments greatly increases the possibility of theft. With the Mac Security Kit, and the built-in locking ports on the Mac computer and keyboard, it is one of the few microcomputers that was designed with theft security in mind.

Home and Community

Traditionally speaking (if we can speak of a “tradition” in microcomputers), the Mac is not a home computer. However, a lot more is going on in homes than used to be. The idea that the Mac, or any other microcomputer, is a good storage device for such things as recipes is not only a waste of money, it is also probably less efficient. (Imagine propping up a $2000 computer on the stove and trying to follow a recipe among the bubbling caldrons!) Rather, the home has become the site for 1) Community organizations, 2) Home Businesses and 3) Home Finances.

Community Organizations

One of the most common uses microcomputer users have made of database programs is membership lists. Americans have traditionally been joiners, and just about some member of every household belongs to at least one group or organization. For example, a surprising number of microcomputer users have been asked to set up database lists for their churches. This can range from a few hundred to thousands of names to keep straight. Likewise, children’s organizations, such as
scouting, team sports and school related organizations often have very large membership rolls. A friend of mine had to keep his community's youth soccer league records involving a complex formula of games, divisions, age and sex groupings. Once the list was set up, revisions were simple, and it was no problem to print out any kind of sub-group listing required.

Some organizations have periodic newsletters. With the graphics and fonts available on the Macintosh and its screen-printer correspondence, very professional and interesting newsletters can be made easily. Similarly, making form letters, dues notices, and application forms for one's organization is greatly facilitated with the Mac.

Most users as individuals probably will not run out and buy a computer to keep their club's records, but the organization itself may find a computer as sophisticated and easy to use as the Macintosh to be worth purchasing. In the large mutual interest groups I have been in, a few individuals end up doing all the work. Since there is no pay, and these organizations are often quite large, keeping track of membership is often more work than any volunteer wants to devote. A microcomputer in these circumstances can often make the difference in having someone who will do the job.

**Home Businesses**

Besides being joiners, Americans are entrepreneurs as well. Most home businesses do not go from garage manufacturing to an international corporation, as did Apple, Inc., but there are a number of very lucrative businesses based in homes. Most significant for microcomputer applications are a number of very successful mail order businesses run from the home. Businesses include real estate brokers, cosmetic and home product dealers, craft and hand-made items, discount distributors (computer software has many such home-based mail order businesses), and small scale "garage/shop" manufacturing. Similarly, there are many specialized newsletters that
are home-produced and highly profitable. Newsletters covering everything from investment tips to gardening techniques are run from the home. The biggest problem solved by microcomputers in these kinds of businesses is keeping track of sales, payment, customers and invoices. With the proper software, the Mac can handle all orders, requiring only the customer's name and address, item and quantity and payment and/or billing information. From this, the Mac can produce a mailing label, invoice and record payment and/or billing. It will also keep track of inventory for re-ordering in the case of mail order distributors.

In addition to the record keeping functions in home-based businesses, which can be handled by most microcomputers given the right software, the Mac can also handle the creation of advertisements, illustrated catalogs and, of course, any text material. This is where the integrated text and graphics of the Mac can really make a difference in the home business. Usually, these home based business cannot afford professional graphic advertisements, especially if the business is one where new products are continually introduced. The Macintosh, combined with the Imagewriter printer, is one of the few microcomputers that can make graphic illustrated, multiple-font camera ready copy for newsletter creation.

A final home-based business is that of the free-lance writer. The word processing functions of the Mac are so important that it seems almost redundant to review them again. Virtually every professional writer makes multiple submissions of articles and books. After even a single review of a manuscript, assuming the publisher returns it (rare), the manuscript appears rumpled. Therefore, either a copy machine copy has to be submitted, which some publishers do not accept, or you pay for additional copies to be typed. With the manuscript stored on disk, new ones can be produced with no more effort or expense than giving the command. Further, every manuscript accepted for publication requires some kind of re-write. Since editing on the Macintosh is so simple, what would have required an entire re-write (and re-type), takes only the time to make the changes and give the order to print the document.
Home Finances

As more and more families have both the husband and wife working, home finances have become more complicated. With the myriad of tax shelters, depreciations, deductions, investments, finance charges, IRAs, Keoghs, and other financial items to keep in order, the old shoe box full of receipts just can't do the job any more. Most home computers can do a good job of keeping home finance records and calculate taxes, and the Mac is really no better than most of the others for this kind of work. In fact, if the only thing a person needs a computer for is home finances, the Mac is probably more than is required. However, if there is a good deal of graphic work and word processing done in the home in addition to home finance computing, the Mac would be a good choice.

Programming in the Fast Lane:
68000 Architecture

You might think the group most disappointed to see the Macintosh will be the programmer/hobbyist, primarily due to the fact that the Mac was introduced without a programming language. However, this group will probably be the most pleased with the Mac. The Mac, unlike the Apple II series, was designed with the end user — the application user — in mind. Now you might ask how in the world you can have a good applications machine without a good programming language? The answer to that is that the Mac's programs were developed on the Lisa and, rather than throwing in a language in ROM, the Mac filled the ROM with utilities, accessible by a myriad of languages. All of these utilities are written in machine language, and to access them from either a higher level language such as Pascal or BASIC, or from your own assembly/machine language routines, saves you a good deal of programming and debugging time. In other words, many of the utilities that are either on disk or that have to be written with most programs anyway are already there. This allows the programmer to concentrate on developing the program instead of the utilities.
Languages for Mac

As we pointed out in the first chapter, Apple will first have Pascal for the Mac, then an Assembler/Debugger and finally a BASIC and a LOGO. The Pascal has been developed by Think Tank for Apple Computer. It interfaces with Quickdraw in ROM and has memory management and file handling capabilities. In fact Apple Computer supports the development of other languages, such as FORTH, FORTRAN, C, and COBOL for the Mac. Access to the user interface and toolbox utility is set up for Pascal calls, but all the information for assembly/machine language development will be provided as well.

When you get your Mac, the best BASIC (in my opinion) for microcomputers will be available. Microsoft Corp. has Microsoft BASIC on disk for $150 for the Macintosh. For anyone who has programmed on an IBM-PC or TRS-80, they will appreciate the power of Microsoft BASIC. To see the speed of your 68000 microprocessor RUN the following timing loop:

```
10 PRINT "START"
20 FOR X = 1 TO 10000 : NEXT X
30 PRINT "FINISHED"
```

See how long it takes between the time you see the word START appear on your screen and the word FINISHED. Try that same program on another micro to give you an idea of how fast your Mac is.

Perhaps the most interesting innovation for microcomputers is the BASIC Apple, Inc. plans for the Mac. It has no line numbers! Right away, some hobbyists may gasp in shock, but once understood, the concept is simple and will help develop better and clearer programs. For example, consider the two different formats for a BASIC program, with and without line numbers where the subroutine beginning at line 200 is a centering routine:

```
10 PRINT "START"
20 FOR X = 1 TO 10000 : NEXT X
30 PRINT "FINISHED"
```
Applesoft BASIC with Line Numbers

```
10 HOME : M$ = "MESSAGE"
20 FOR X = 1 TO 20
30 GOSUB 200
40 NEXT X
...
200 HTAB 20 - LEN(M$)/2
210 PRINT M$
220 RETURN
```

Applesoft BASIC without Line Numbers

```
HOME : M$ = "MESSAGE"
FOR X = 1 TO 20
GOSUB CENTER
NEXT X
...
CENTER
   HTAB 20 - LEN(M$)/2
PRINT M$
RETURN
```

In working with subroutines, especially in large programs, it is a good deal easier to remember a label for a subroutine than it is a line number. (Oldtimers who used Apple's Integer BASIC may remember having subroutines jump to labels.)

Finally, the Mac is set up for a Programmer's Development Switch. This switch, located on the lower left side near the back, will allow for programmer's accessing the 64K ROM for using its built-in subroutines. Thus, it is a simple matter to move from the desktop environment of the application user to the programming environment for system or applications programming. So, after initial disappointment, I think programmers will find the Mac to be a hacker's delight.
Technical Data

The following technical data will help programmers understand what's inside the Macintosh hardware:

**Microprocessor:** 32-bit MC68000. Clock frequency 7.8336 MHz.

**Memory**
- RAM: 128K
- ROM: 64K
- DISK: 400K

**Disk system:** One built-in using 3½ inch microfloppy hard-shell disk. One external disk drive connector. Two disk support.

**Monitor:** Built-in black and white 9-inch monitor. 512 X 842 square pixel resolution.

**Sound:** Four-voice sound generator with eight-bit digital-analog conversion.

**Keyboard/Mouse:** 58 keys (double option and shift keys). Rolling mechanical mouse.

**Clock/Calendar:** Battery operated CMOS clock/calendar.

**Ports:** Two serial, one external disk drive, one sound, one mouse.
Software

At the outset, the Macintosh will have limited software, but over 100 developers along with Apple Computer are working busily on additional software. The following is the software planned for the Mac at different stages. Since plans and realities are often at odds, the software will be listed in the sequence of expected development with no dates given. Depending on when you read this, some of the software may already be out.

1. MacWrite (Apple Computer) Word processor now available. (See Chapter 6.)

2. MacPaint (Apple Computer) Graphics program now available. (See Chapter 5.)

3. Microsoft BASIC (Microsoft, Corp.) This very popular BASIC on microcomputers is now available.

4. Multiplan (Microsoft, Corp.) Electronic worksheet, budget planning and modeling program is now available.

5. MacTerminal (Apple Computer) Terminal program for modem communications. Requires modem.


8. Microsoft Chart (Microsoft, Corp.) This program lets the user make various charts and graphs from numeric data.
9. Microsoft Word (Microsoft, Corp.) This word processor makes full use of the Mac mouse and prints exactly what you see on the screen. It allows transfer between documents.

10. Microsoft File (Microsoft, Corp.) Database program for the Mac.

11. Think Tank (Living Videotext, Inc). Described as an “Idea Processor,” Think Tank is a planning and outlining program.

12. 1-2-3 (Lotus Development Corp.) An integrated software package including spreadsheet, graphics and database programs that work interactively.

13. DB Master (DB Master Associates). Database program with dynamic filing, report generation, sorting and other general purpose data base functions.


18. Microsoft Expert System Series (Microsoft, Corp.) This series of budget programs for the Mac provides professional budget planning and analysis.
Hardware

Like software, various companies along with Apple are developing hardware for the Macintosh. Its availability, like the software, will depend on when the companies complete work on the product and when you are reading this.

1. Imagewriter Printer (Apple Computer) Serial version of Apple's Imagewriter dot-matrix printer.

2. External Disk Drive (Apple Computer) Second disk drive for Mac.


4. Carrying Case (Apple Computer) Fabric reinforced case for Macintosh. This case easily fits under airplane seat.

5. Modem (Apple Computer) External modem plugs into serial port with a rate of 300 BAUD or 300/1200 BAUD available.

6. Telephone and Modem Interface (Tecmar, Inc.) Modem for Macintosh.

7. Winchester Hard Disk (Tecmar, Inc.) Mass storage Winchester technology disk system.

8. Print Spooler (Tecmar, Inc.) Spools printer output allowing user to do other things with computer during printing.


10. Security Kit (Apple Computer) Locking devices to prevent theft of computer and keyboard.
On the Way . . .

With any new machine, especially one that uses as many innovations as the Macintosh, its success or failure will depend on what software is developed for it. With the number of programmers on the Apple II series machines, we can expect a good number to be attracted by the 68000 32-bit architecture of the Mac. In time, there will be as much software for the Mac as there is for the Apple II series machines. Apple Computer actively supports the development of software for all its machines. However, with all of the newly minted Apple programmers, it will probably take a lot less time to see a cornucopia of software.
Chapter 3

Cranking Up the Mac

Setting Up the Mac

You will find the Macintosh to be one of the easiest computers to set up. Take it out of the box and make sure you have the following:

1. Main Unit — the thing that looks like a TV set.
2. Keyboard.
3. Power cord — round and greenish.
5. Mouse — little box with square button on it and attached cord.

First, connect the keyboard cord to the keyboard and console. The cord goes from the left side of the keyboard to the right side of the console. Second, plug in the mouse. Facing the back of the console, the mouse connecting port is on the far left side. Plug it in and turn the screw to secure it. If you are right-handed, bring it so that it is on the right side of the console. Left-handed people should bring it so that it is on the left side of the console. (You will be using the mouse a lot, and having it on your “strong handed” side will make a difference.) The cord from the mouse should be facing away from you. Finally, plug the power cord into the slot directly below the on/off switch on the back. Plug it into a wall socket and you're all set.
The Apple Macintosh with built-in monitor and disk drive, keyboard and mouse.

Booting Your System

Once you have set up your system, all you have to do is flip the on/off switch to “on.” An icon disk will appear on your screen with a blinking question mark on it. Insert your disk into the slot opening. The metal end of the disk goes in first, and the circular metal disc on the disk should face downward. When it clicks into place, the disk icon will be replaced by a (gulp!) smiling Mac icon, and then a welcoming message will appear and finally the “desktop.”
In the upper right-hand corner is the icon for the disk you inserted. For purposes of illustration, let's use a disk we'll call "Primer". Right under the disk, it would be titled Primer. You will also see a little black arrow. Place your hand on top of the mouse, leaving the mouse on a desktop and move it around. The arrow moves. Think of the arrow as an extension of your arm that you can control with the mouse. You use it to point at what you want on the desktop. You click it to choose what you want. Move the arrow so that it is over the disk icon in the upper right-hand corner. Press the button once. The disk turns black — inverse. That means you have chosen the disk.

Now that you have chosen it, you want to open it to see what's inside. There are two ways to open the disk. The easiest is to place the arrow on the item and click the mouse button twice. The other way is to go to the File menu, open it and choose the Open option. We'll look at the menu options later. For now, just place the arrow over the disk icon and give it a double click. The disk now opens and you can see the items on your       

57
disk. Some of the items will be programs or files you can open and execute and others will be folders with more options to choose. Whatever your choice, just point and double click to open it up.

On the Primer disk will be MacWrite and MacPaint programs, and some other items we can use for storing things we create. To run MacWrite, just place the arrow on the MacWrite icon and give it a double click. There is a System Folder and an Empty Folder, MacPaint, and Font Mover, and they are chosen just like we do everything else — point and click.

Now, let's put the disk back. In the upper left-hand corner of the window is a little white box. Place the pointer in that box and click the mouse. This closes the window. As a rule of thumb, always close something as soon as you are finished using it. You can also close it from the File menu by choosing Close.
The Menus

When you first get started, you will be shown a set of desktop menu labels. They are arranged along the top of the desktop. From left to right you will see an apple icon, File, Edit, View and Special labels. To open a menu, place the pointer over the menu label and, holding down the mouse button, look at the menu. As soon as you release the button, the menu disappears. To choose a menu item, keep the button pressed and move down the menu. As soon as the pointer is at your choice (the choice will invert in color), release the button. Let's take a look at each of the desktop menus:

Apple Icon Menu

This menu has the following:

- Scrapbook
- Alarm Clock
- Note Pad
- Calculator
- Key Caps
- Control Panel
- Puzzle
Each of these items can be chosen whenever you need them, and replaced by pointing to the square in the upper left-hand corner. The following is a short description of each of these items.

**Scrapbook**  This is a little tricky, but basically it is used for storing often used text and graphics. When you create a text message or graphic you want to use a lot, such as a logo, you place it in the Cut or Copy buffer, and then Paste it in the Scrapbook.

**Alarm Clock**  This is an alarm clock/calendar.

**Note Pad**  This is a handy little pad to jot down notes when you're in the middle of another project. Let's say you get a phone call. So, instead of interrupting your file, you just pull down the Note Pad and write a note.

**Calculator**  This is as its name implies. Whenever you're working on something and need to do some quick calculations, just pull down the menu and get the calculator. It is operated by using the mouse pointer and pressing the mouse button, working just like a four function calculator. Press the calculator key by pointing and pressing the mouse button.

**Key Caps**  This shows you the various keypresses and characters you get. Press the option and shift keys to see keyboard characters. (In Chapter 4, we will cover the keyboard in detail.)

**Control Panel**  This allows you to adjust various dimensions on your desktop, keyboard, sound and screen pattern.

**Puzzle**  This is one of those number shifting puzzles. Try to get the numbers in numerical order while the boss isn't looking.
File Menu

When you first open the file menu, you will see the following options:

- Open
- Duplicate
- Get Info
- Put Back
- Close
- Close All
- Print
- Eject

Some or all of the options may be in a faded gray font, and others in a clear black font. Those that are faded cannot be used at the present time. For example, you may see that only Close and Close All are in black and the rest are faded. That means you have to choose something to be opened, duplicated and so on before that choice is viable. With practice, you will understand more about what is “applicable” and “nonapplicable” on the menus.

Open  This will open whatever file you have chosen. Usually clicking the mouse button will be used to Open a file.

Duplicate  This is very handy with creating duplicate folders. To try it out, place the pointer over Empty Folder and click the mouse. Now choose Duplicate or press the command key and D keys. An untitled folder will appear. Later, we’ll show you how to use this for organizing your desktop.

Get Info  This gives you some information about the chosen item.

Put Back  You can move things around your desktop, in and out of folders. This choice will put them back where they belong. More on this later.
Close  This closes a single current file. Usually this is done by clicking the little box in the upper left hand corner of a current window.

Close All  This will close all the files you have open.

Print  This prints the contents of a file for you. It tells you what's in it.

Eject  When you are all finished, you eject the disk from the drive with this choice. You can use the command key and E key for ejection as well.

Edit Menu

You will be using the Edit Menu a good deal when you're working with your word processor, and to some extent with MacPaint. There are some applications with it on the desktop, but not many.

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>*Z</td>
</tr>
<tr>
<td>Cut</td>
<td>*X</td>
</tr>
<tr>
<td>Copy</td>
<td>*C</td>
</tr>
<tr>
<td>Paste</td>
<td>*V</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>*A</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td></td>
</tr>
</tbody>
</table>

Undo  *Z  The last thing you did will be undone in text or graphics.

Cut  *X  The highlighted portion of your text or selected graphics will be cut from the screen and placed on the clipboard.

Copy  *C  The highlighted portion of your text or selected graphics will be placed on the clipboard.
Clear  The selection is removed, but it is not placed on the clipboard.

Select All  *A  This chooses (inverses) all icons in the current window.

Show Clipboard  This shows what, if anything, is currently on the clipboard by presenting a window.

View Menu

This menu is something like a catalog option. It is used to present the disk contents in different fashions.

   by Icon
   by Name
   by Date
   by Size
   by Kind

The default desktop arrangement is by Icon, but if you would rather have it presented in text and arranged by Name, Date, Size or Kind, the View Menu will do it for you. Clean up just rearranges things neatly. Whatever arrangement you choose will remain that way until you change it back. So if you arrange your files by name, for example, turn your computer off and then on again, it will still be arranged by name. Experiment with the different arrangements and see which you like best. When you are finished, put it back to arrangement by Icon.

Special Menu

The Special Menu cleans up the screen and empties the trash.

   Clean Up
   Empty Trash
   Erase Disk
Empty Trash  BEWARE of this one. This is used to delete files you no longer want on your disk. Whatever is in the trash will be deleted from the disk. Never put your application programs in the trash!

Mousing Around

We've got the Mac started up, and we know how to choose things and read the menus. Practice will make it very simple. Now let's see about moving things around and creating extra folders.

Dragging with the Mouse

When you want to move something from one place to another, you “drag” it with the mouse controller. To do that you just point to the desired object, hold the mouse button down and, keeping it held down, move the object to wherever you want. When you get it where you want it, release the button. Let’s try it with the trash can. Move the trash can from the lower right-hand corner to the lower left-hand corner. Now move it back. That won’t do anything other than move it. The real value in moving things is putting them into and removing them from folders. This helps you to arrange your desktop in a useful fashion.

Duplicating Folders

The first thing we will need is a folder for putting things we create on MacWrite and MacPaint. Since we have only a single Empty Folder into which we can put things, we will need to create some more. To do that use the following sequence:

1. Select Empty Folder with the pointer and click button. It should turn black.
2. Go to the File Menu and select Duplicate. (Or simply press the command key and D.)

3. An Untitled folder will appear. Go to the Edit Menu and select Cut. The label Untitled will disappear.

4. Using the keyboard, type in New Folder.

5. Using the mouse, drag the New Folder over to the side where it will be out of the way.

Now you have another empty folder in which you can put things. In the chapters on creating word processing files and graphic files, you'll see how to put things in the folders.

Taking Out the Trash

Using your New Folder, we will see how to get rid of things you no longer need. (We'll ditch the New Folder since we can make as many as we want.) Here's the procedure:

1. Using the mouse, drag the New Folder over the Trash icon.

2. When the Trash icon flashes black (inverse), release the button. The New Folder is now in the trash.

At this point, you can erase the New Folder from the disk, leave in the trash, or remove it from the trash and put it back on the desktop. To permanently remove it from the disk, go to the Special Menu and choose Empty Trash. You will be notified that the contents of the trash are being removed from the disk. REMEMBER, once you select Empty Trash, whatever is in the trash will be removed permanently.
To remove something from the trash, first you have to get into the trash can. Do that by running the pointer over the Trash icon and click the mouse button twice. The trash can will then open and there will be your New Folder, if you haven’t already emptied the trash. To get it back onto the desktop, just place the pointer over the folder icon and, holding the mouse button down, drag it to desktop.

Do NOT use the trash as a temporary storage area; it is NOT a good idea. Let’s say you’re working on several files simultaneously, and you want to clear the desktop. So you place some material in the trash just to get it out of the way temporarily. You plan to retrieve the material you want from the trash later and leave the rest there. However, if you eject the disk, the trash is automatically emptied. For temporary storage in situations where the desktop is getting crowded, just create another empty folder. Name it Temp. Storage (or something like that), and stick things in there. Once you have finished, place the files you want to keep on the desktop and stick the Temp. Storage folder in the Trash.

Write-Protecting Your Disk

Since we’re on the topic of trashing material, we should learn how to protect against destroying the contents of a disk. Besides making back-ups of important materials on separate disks, another way to ensure against accidental erasure is to write-protect your disk. If you are familiar with the 5¼ disks, you know all about write-protect tabs. With the disk used on the Mac, the write-protect tab is built-in. It’s that little red square in the corner of the disk. If you can see that red window, your disk is not write-protected. The red flag is a warning flag. It means you can write to and erase files from your disk. By moving the red flag down, so that you cannot see it from the top view of your disk, you protect against accidental erasure. The only problem is that when you’re creating files, you will want to write to the disk. The best thing to do is to protect your application masters and disks filled with important files and leave the write-protect off work disks.
Folders Within Folders

Organizing your desktop and files is much like organizing an office. Since the Mac can handle a great amount in a small space, sooner or later that desktop is going to get filled up. This will require making more general categories and subcategories. To understand and see how this works, imagine a building full of filing cabinets. There are 10 rooms in the building, numbered from 1 to 10. Each room has 26 filing cabinets with letter designations A-Z. Each cabinet has six drawers, numbered 1-6. To identify a drawer we would use the room number (1-10), cabinet designation (A-Z) and drawer number (1-6). Therefore, if a file is in 5-G-3, we would find the file in Room 5, Cabinet G and Drawer 3. Using the three digit identifier, we can handle 1560 file drawers.
To translate this to the Macintosh desktop, we will create three folders. This is done using the Empty Folder just like we did with the New Folder we created. First create one folder and name it Room 5. Then create two more, naming them Cabinet G and Drawer 3, respectively. Once you have all three folders, take the one named Drawer 3 and place it in Cabinet G. Now, take the Cabinet G folder and drag it into the Room 5 folder. Of the three folders you just created, you should now be able to see only one, Room 5.

To find the Drawer 3 folder, first open Room 5, then open Cabinet G, and inside Cabinet G you will find Drawer 3. Using this kind of organizational scheme, you can store as much as you want. You may even create an index file folder to tell you how everything is organized. It is very important to close all of the folders as you move out of them. This can be done either by clicking the little box in each window as you finish or choosing the Close All option from the File Menu.
Window Dressing

Sometimes when you access a folder or some other file, the window is too large or too small. For example, if you have only a single file in a folder, then you will not need very much of the desktop. On the other hand, when you have a lot of files in a folder, you may have to make the window larger. To change the window size of a current desktop, you run the pointer to the lower right-hand corner where there are two overlapping squares. Press and hold the mouse button and drag the window to a larger or smaller size. You can move the window size both horizontally and vertically. With certain applications adjusting the window size will be more or less significant.

Scrolling Windows

In addition to changing the window size, you can also scroll the window vertically and horizontally. To see how this works, first make a small window on your desktop. It should be small enough so that you cannot see all of the icons on the desktop. Now place the pointer in one of the arrows in the corners and press the mouse button. If nothing happens, go to the arrow on the other end of the bar and press the mouse button. The icons should scroll across the window. Try doing this with both the horizontal and vertical sets of arrows until you see how to control scrolling. You can also drag the elevator between the arrows to scroll. Just drag the box and when you stop and release the button, the screen will scroll to the box position relative to the window size.

Disk Work

Working with the 3½ inch microfloppy disks is so simple that not a lot needs to be said about using them. However, there are some basic considerations you should understand. A disk must be initialized to work on your Mac, but all this requires is putting an uninitialized disk into the drive. The Mac automatically recognizes it as being uninitialized and will initialize it for you.
The problem is preparing a "booting disk" or "start-up" disk. If you initialize a disk simply by inserting it and giving an affirmative response to the initialization query, that disk will work fine once Mac has been booted by a start-up disk. However, when you first start your system, that disk will not work. To make a start-up disk, use your system disk to make a copy of your system files necessary for start-up. You should definitely have some start-up disks, but not too many. That's because the files necessary for start-up take up a lot of room, and for most of your disks you will want plenty of room to save files.

**Saving Files to Work Disks**

When you work with an application program, most of the material you create should not be saved to the same disk with the application. Instead, you will want to save your creations to "work disks" or "file disks." These disks will contain all the data from the application, but they will not have the application program on the disk. The steps for saving and retrieving files is simple.

**Saving Application Material to Work Disk**

1. Run the application program and create the file you wish to save.

2. When you are ready to save the document, one of the choices you will have is Eject. Choose Eject.

3. Your application disk will eject. Insert your work disk, enter the file name and choose Save.

4. Follow the prompts in swapping disks.
Now that your file is saved on the work disk, let's see about getting it back. This is important, especially for text files you've been working on with MacWrite or some other word processor. You write part of a report, save it to a work disk and turn the machine off. The next day you come in and want to work some more on the report. You just load it up and continue where you left off. The following procedure is used for reclaiming files:

1. Run your application program from your application disk. Close the "untitled" file, and then from the File Menu choose Open.

2. When the option window comes up, choose Eject.

3. Insert your work disk, select the desired file and choose either Open or Open Copy. If you choose Open, your file will be loaded with the file name under which it is stored. If you choose Open Copy, the same file will be loaded, but it will be untitled. Usually you will choose Open since you are simply adding to the file.

4. Follow the prompts for swapping disks.

If you do a lot of work with text and graphics, it can get tedious swapping disks. Most people who have a high volume of such work usually have a second disk drive. This makes life a lot simpler since you can stick your application program in one drive and your work disk in the other. Then you won't have to swap disks so much.

**Summary**

With this chapter we've seen how to really start working with the Mac. If you have been following the examples, you can see how simple it is to organize your work with the Mac using the mouse and keyboard. The compact size of the Mac belies its
“Office in a Computer” capabilities. The menu selected operation makes desktop arrangement simple. By making and storing successive folders, you can have a great deal of information organized in a compact and logical order. Changing various window sizes allows the user to make maximum use of the screen space available. Similarly, by storing completed work on work disks, almost half a megabyte of work can be placed on a 3½ microfloppy.
The Keyboard-Mouse Connection

This chapter is a detailed overview of the Mac keyboard and options where the keyboard or mouse can be used to perform tasks. Since the Mac keyboard is remarkably "clean" in comparison to other microcomputer keyboards, this chapter is relatively short. This is not to say that the keyboard is limited or leaves out important computer functions, but rather these functions are handled in conjunction with the mouse or with special keys.

The Keyboard Layout

First, let's look at the keyboard's layout.

Lower Case and Bottom Symbol

Just as on a normal typewriter, the default condition of the keys on your Mac are lowercase. As soon as you press a key, you get the lowercase version of that key. On keys with two symbols, the one on the bottom of the key is printed.
Upper Case and Top Symbol

Uppercase keys also work in the same way as they do on a typewriter, with one exception. When the Caps Lock key is "on", all letter keys will be in upper case; but the upper character of keys with two symbols still requires pressing the Shift key. For example, if you have the Caps Lock on and press the key with the semicolon and colon on it, you will get the semicolon. You always have to push the Shift key to get the character on the top part of the key.

Option Keys

Option Keys
Option keys give you a third symbol on some of your keys. These characters are made by holding down the Option key and another key. It will take some practice to get to know what symbols are associated with Option keys since the Option symbols are not printed on the keyboard. However, if you use the Key Caps window from the Apple Logo menu, you can quickly check what symbols go with the various keys simply by pressing on the Option key. Special characters such as the British pound sterling symbol and the Japanese yen symbol can be useful in international business communications. Likewise, there are some Shifted Option symbols as well.

**Shifted Option Keys**

If you are wondering what you will do with the option set, it's important to remember two things. First, with an Image-writer printer, everything that appears on the screen will be printed to paper. Therefore, even the strangest looking symbol will be printed. Secondly, the Mac is truly an international microcomputer. It allows different symbol sets of many languages to be printed. Similarly, for certain applications, such as scientific ones where special symbols are frequently used, the various option symbols are very important.
Other keys, such as the Backspace, Tab and Return, work very much like their equivalent keys on a typewriter. The Backspace key, under most circumstances, will back over and erase whatever you last entered. On a typewriter the Backspace key just backs up but does not erase. The Tab key, on applications such as MacWrite, jumps to the next tab position. Finally, the Return key acts like a carriage return on a typewriter. It will be used differently in different applications and in programming, but for the most part treat it as a carriage return.

Special Keys

These are some of the keys you will not see on a typewriter. We’ve already seen one use of the Option key, making special characters. However, it is important to note that in certain applications, the Option key is used for other things as well. For example, in MacPaint, to be discussed in the next chapter, we will see that the Option key has a special effect in dragging graphics. Therefore, while each key has general functions, there are also specialized functions for different applications.

The Enter key is something like the Return key, but it usually signifies that a certain portion of entered data is ready for entry into the computer. Sometimes it is used for issuing commands.

Finally, the Command key (⌘), in the lower left-hand portion of your keyboard between the Option key and space bar, is used in conjunction with other keys to give commands. This key is very dependent on the application you are using. On the desktop, we saw that it is used with different menus. For example, pressing Command-E will eject your disk when you’re ready to quit. However, the commands only work under certain conditions or when the command is “active.”

Mouse-Key Connection

There are several times when you are given the option of using the mouse or a command key to get something done. At first as you are learning the system and different applications, you
will probably be using the pull-down menus and the mouse button to issue commands. However, as you become more familiar with your system and applications, you will probably want to use the command key combinations more. It will save time and be more efficient. Of course you can use the mouse if you want, but the command key sequences were incorporated into the Macintosh system to save time.

For Old-timers

Many of you may wonder what happened to the Escape, Function, Cursor and Control keys found on other Apple and non-Apple computers. These keys have been replaced by the Command and Option keys and the mouse.

A more important consideration lies in interfacing and using the Mac with such devices as your printer. Usually, a control or escape sequence is set up using the CHR$ functions or POKEing in ASCII values from BASIC. This is especially important in Input/Output (I/O), and most printer instructions for special characters are given in terms of ASCII values. Full information for interfacing the Mac with printers other than the serial version of the Imagewriter will be available as more products and interfaces become available for the Mac. However, since the standard ASCII code is used with Macintosh, it may be possible to send the same coded sequences that you are used to on other computers.

With applications, however, the code sequences are in the software. Using the Mac with word processors, spreadsheet programs and other applications that send information to printers or out modems, the necessary code is imbedded in the applications. This is no different than software on other computers. The big difference between the Mac and other computers, using applications such as MacWrite and the Imagewriter printer, is that the keystrokes visible on the screen will be what you get in your output.
To get started with MacPaint, turn on your computer and insert your diskette with the MacPaint program. Open the MacPaint disk icon with a double click of the mouse or choosing Open from the File Menu. Then, open the MacPaint program in the same manner. Your disk drive will whirr for a while as the program loads, and soon you will be presented with the following screen:

![MacPaint Interface](image-url)
We will discuss the MacPaint screen in four parts:

1. **Menus**: The options along the top of the screen.

2. **Tools**: The icons along the left side of the screen.

3. **Patterns**: The different patterns along the bottom on the screen, including the line widths in the lower left-hand corner.

4. **Canvas**: The area where you do your drawing and print text, initially labeled “untitled.”

The Menus

Let's get started by opening all the menus. We'll just open them up to have a quick reference as to their contents and then discuss the uses of the menu choices as we go along.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Goodies</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Undo</td>
<td>*Z</td>
<td>Grid</td>
</tr>
<tr>
<td>Open...</td>
<td>Cut</td>
<td>*K</td>
<td>FatBits</td>
</tr>
<tr>
<td>Close</td>
<td>Copy</td>
<td>*C</td>
<td>Show Page</td>
</tr>
<tr>
<td>Save</td>
<td>Paste</td>
<td>*U</td>
<td>Edit Pattern</td>
</tr>
<tr>
<td>Save As ...</td>
<td>Clear</td>
<td></td>
<td>Brush Shape</td>
</tr>
<tr>
<td>Revert</td>
<td>Invert</td>
<td>*E</td>
<td>Brush Mirrors</td>
</tr>
<tr>
<td>Print</td>
<td>Trace Edges</td>
<td></td>
<td>Introduction</td>
</tr>
<tr>
<td>Print Catalog</td>
<td>Flip Horizontal</td>
<td></td>
<td>Short Cuts</td>
</tr>
<tr>
<td>Quit</td>
<td>Flip Vertical</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rotate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For an orientation to MacPaint, take a quick look at the Introduction and Short Cuts under the Goodies Menu. The Introduction shows the names of the icons, and Short Cuts shows you how to use the double-click to get various effects.

**Paint and Erase**

To get started, we will use the default tool, the paintbrush. (If you de-selected the paintbrush, place the pointer over the paintbrush icon and press the mouse button. The tool you select will be inversed.) Using the mouse, move the pointer over to the canvas, and it will turn into a black dot on your screen. Now, hold down the mouse button and drag the dot across the screen. When you move the mouse and hold the button, you create a drawing with your brush. Experiment for a while to get the feel of it.

Next, move the pointer over to the tool icons area and select the eraser. It is directly below the pencil icon. When you move back on the canvas, you will see a little white box instead of a black dot. Move the box over some portion of your drawing, press the mouse button and move the box away. The portion of your drawing where you held the eraser and pressed the button is erased. Now, hold the button down on the mouse and run the eraser over the drawing just as you would use a normal eraser and erase some more. If you want to erase the entire canvas, move the pointer over the eraser icon and press the mouse button twice. (Click, click and everything disappears.)
Undo

Now that you can draw and erase, you have the fundamental elements under control. You can do a great deal more with MacPaint, but for starters, all you need is draw and erase. Before we go on, though, there is an important little item to know. Draw something and and erase a portion of it. Move the eraser away from the portion you erased and press the Command key and the Z key. Presto! The part you just erased is back. Now, press the Command and Z keys again. It's erased again. The Command-Z combination let's you undo what you have just done. It is very useful in situations where you accidentally erase or draw something you don't want.

Changing Brush Shapes and Patterns

So far all we have drawn are lines with the default brush in the default pattern. To change the shape of the brush, place the pointer over the brush and click the mouse button twice. You will be given a choice of different brush shapes. Place the pointer on the shape you want and click the button. When you paint, you will now have the new shape for your brush. The following is a sample of different brush shapes and sizes:

Now let's change the brush pattern. First, choose a big fat brush shape. Next, move the pointer to the bottom of the screen and point to one of the small pattern boxes. (Don't choose the solid black pattern since that is what you already
As soon as you point and select a new pattern, the pattern appears in the largest of the pattern boxes on the bottom of your screen. Now, return to the canvas and start painting. Instead of a solid black line, your painting is in the form of the new pattern. Experiment with different patterns. Later, we'll look at some more tricks with patterns.

**Brush Mirrors**

Open the Goodies menu and select Brush Mirrors. You will be shown a box with horizontal, vertical and diagonal lines. Place the pointer over each line and click the button. (The lines will get fat as soon as they are selected.) Select Ok, and go back to your canvas. Now when you draw with the paint brush the "mirror" of your drawing appears. The following is an example of what you might get:

![Brush Mirror](image)

**Spray Can and Pencil**

The spray can works pretty much like the paint brush except it only has a single size and it will not work with the mirrors. By holding down the mouse button and running the spray pattern, you can "spray paint" an area of your canvas. It will spray in any of the patterns on the bottom of the screen. Try spraying with different patterns to see the effect. Using one of the patterns with dots, I was able to create a pattern that looked like a lawn that I couldn't quite get with the brush.
Likewise, using the brick pattern, I was able to make a crumbling-looking brick wall. Very rustic. Try experimenting to see what you can get.

The pencil can be used for fine drawings, but it will not do mirrors or use the different patterns. However, the pencil has a special function for really fine changes in drawings. This is with the Fat Bits. To get Fat Bits, either choose it from the Goodies Menu or click the mouse button twice while pointing at the pencil icon.

When Fat Bits appears, you will see a small window in the upper left hand corner of your screen. This is the portion of the canvas represented by the pixel in the rest of the screen. When you point the pencil to a pixel and click the mouse, the block will be erased. Point the pencil at an empty space and a block will appear. This allows you to make fine corrections to images you have created. For example, the following shows how a figure looks in both the pencil and Fat Bit modes:
You can use any of the icon tools with Fat Bits, and after practice, it will become an indispensable graphic editing tool.

The Paint Can: Filling in An Area

One of the most interesting features of MacPaint is its fill capabilities. The icon of the can pouring paint, right next to the spray can, will fill up an enclosed area. First, get out the paint brush, and draw an enclosed area. Now, select an interesting pattern from the patterns on the bottom. Next, select the pouring can icon, and move it to within the enclosed area you made with the paint brush. Click the button and the area is immediately filled with the pattern. Now, go select another pattern, and place the pouring can outside the enclosed area and click the button. Everything on the inside of the pattern is one pattern, and everything on the outside is another. Using the brush mirrors, you can create some really interesting designs by filling in the enclosed areas with different patterns. If you try to enclose an area with a “leak” (a broken line), the entire area will be flooded. Experiment with the pouring paint can to see what you can do. It’s a lot of fun to fill in the canvas with a pattern, and using the eraser, clear a path. Then “pour” in another pattern in the erased path.

Making Your Own Pattern

In addition to using the patterns supplied with MacPaint, you can custom design your own patterns. Use the following steps to create your own pattern.

1. First place the pattern to be changed in the “active” box. That is, just select a pattern so that it goes into the big pattern box. (I usually take the blank white pattern.)

2. Place the pointer on the big pattern box and click the mouse button twice.

3. Two boxes will appear, labeled OK and Cancel.
4. Using the pointer, just like the pencil in Fat Bits, plot out your design in the OK box. The OK box will show you the Fat Bits, and the Cancel box will show you what your pattern looks like. (Just draw an “X” if you can’t think of anything else.)

5. When you’re finished, select OK and click. Your pattern will be stored in the pattern box on the bottom you originally selected. (If you change your mind and do not want to make a new pattern, select Cancel.)

The best way to work with creating patterns is to first select some pattern you like and bring it up to the pattern editor. In the Fat Bit mode, they really look different than they do as patterns. However, it will give you a good idea of how to create different effects. Unfortunately, when you leave the MacPaint program, your newly created patterns are lost. So, if you get a really neat one, draw it on the canvas in the Fat Bit mode with the pencil and save it as a picture. Then when you work with MacPaint again, you can see how you created it.

**Saving Pictures**

In Chapter 3 we covered saving material, but just in case you don’t remember (or skipped that chapter), here’s how to do it with MacPaint.

1. When you are finished drawing your picture, either choose Save or Save As ... from the File Menu or click the square in the upper left-hand corner of the canvas. If you choose Save As ..., you will be able to save an old drawing you have changed under a new name. This is useful if you want two versions of a drawing. If you choose Close you will be presented with the following screen:
2. If you choose No, the canvas will disappear and you will have to open a new one by selecting New from the File Menu. A choice of Cancel will just go back to your painting. Choosing Yes will lead to the following screen:
3. If you are going to save your drawing to another disk select Eject. Your application disk will be ejected and you will be instructed to insert the disk on which you want to save your picture. To save it to the disk you are using, write in a file name you have not used yet. The file name will appear in the rectangular box below Save document as: when you key in the name from the keyboard. If you are saving an already titled picture, that name will appear in inverse in the rectangular box. By clicking Save, your drawing will be saved over the old picture on your disk that had the same name.

**Retrieving Your Pictures**

Once you have saved a picture, you will want to get it back again. To do this, get rid of your untitled canvas by closing it and opting not to save it. Then go to the File menu and select the Open... choice. You will then be presented with a menu of all of your MacPaint files. (If you cannot see them all, place the pointer in one of the arrows and scroll the files by clicking.) Place the pointer on the file you want retrieved and click the mouse. You can either Open the file under the name you saved it as, or choose Open As and it will be untitled. If your picture is on another disk, select Eject, and when you put the disk containing the MacPaint pictures into the drive, you will be given the file names of the pictures on the new disk. Proceed to Open the one you want. It will then be placed on the canvas for you with its title on the top of the canvas window.

**Getting in Shape**

The bottom half of the tool icons are a number of shapes. The hollow shapes are used for creating the indicated shapes, such as squares, rectangles, ovals, and so forth. Those on the left are empty, and those on the right are filled with the current pattern. The rectangular and rounded corner boxes begin drawing their shape in the corner of the figure as soon as you move the mouse holding down the button. The circular, oval shapes and irregular shapes start where the pointer begins.
Straight Lines and Line Widths

Just for fun, try taking the pencil and drawing a straight line. People more artistic and coordinated than I probably won't have any trouble. To draw a straight line with the pencil, I simply hold down the shift key while I move the mouse. An easier way to draw a straight line is with the line icon, located to the left of the eraser. Select the straight line, and pick a point on the canvas. Press the mouse button and draw with the mouse. A line will appear pivoted on the point where you first pressed the mouse button. Move the mouse around until the line is where you want it and release the button. Diagonal lines are a bit saw-toothed, but they are as straight as you can get them. Vertical and horizontal lines will be perfectly straight if you draw them while holding down the shift key.
Now look at the box of lines in the lower left-hand corner of your screen. These are the line widths of your straight line and your shapes. By selecting different line widths from the box, the straight line and your shapes will appear in different widths. The cross-shaped cursor gets fatter or skinnier depending on the width of your line. Experiment with the straight line and shapes to see what effects can be made with the different line widths.

**Cut, Paste and Move: Lasso and Selection**

At the very top of your icon tool set is a lasso icon and square made of broken lines icon. The latter icon is called “selection.” These tools are used for moving sections of drawings around the screen and making changes.

**Lasso**

The lasso icon “ropes” an image and tightens around it so that only the image itself is surrounded. This is good for irregular shapes. For example, the following shows two cats:

- **Original Cat**

- **Copy Cat Inverted**
The original cat was drawn in the middle of the screen. Using the lasso icon, the figure was enclosed in the lasso by holding down the mouse button and drawing around the cat. As soon as the line around the cat was completed, the button was released. The figure will appear to shimmer once it is surrounded by the lasso. Move the lasso icon on and off the figure. You will notice that it changes from a lasso to the pointer arrow. When you see the pointer arrow, press and hold the mouse button, and you can drag the lassoed figure anywhere on the screen. If you drag the figure over another figure it will not erase the second figure. You can see that by moving it again off the second figure.

**Copying and Inverting**

With the lasso in place, you can go to the edit menu and make a copy of the figure by choosing Copy or pressing the Command and C keys. Then, by choosing Paste or pressing the Command key and V key, you can make a second image of your figure appear on the screen. This is how the two copies of the cats were made. If you choose Invert from the Edit menu while the lasso is in place, your figure will be reversed in color. Since the inverse whiskers of the cat against a white background would be invisible, I made a black rectangle, moved the cat onto the rectangle and then inverted the lassoed cat.

**Select**

With the select icon you can do everything the lasso icon can do, except instead of surrounding just the figure, you get a rectangular area around the figure. However, while you do not have the precision of the lasso, you can do lots more. To select the entire canvas, click the mouse button twice while the pointer is on the select icon.
Tracing Edges with Select

One of the most interesting things you can do with select is to trace edges. The trace feature of select allows both practical and artistic application. For example, the following illustration began with the original two crossed lines. A single trace gives the lines the appearance of two streets intersecting. Multiple tracing creates interesting designs from the same original lines. Using box shapes, you can make a “frame” effect with the trace function. Choose Trace Edges from the Edit menu.

Flipping Out

Another set of functions possible with select, but not possible with the lasso is flipping and rotating figures. When a figure is enclosed by select, from the Edit menu, you can choose to move the figure in a number of different directions. Look at the
following figure. The original arrow is pointing to the right. By using the horizontal flip, it faces in the opposite direction. Then by choosing rotate, it points straight up. From the straight up position, a choice of flip vertical will have it pointing straight down. (If you flip the original arrow vertically, you will notice very little since all it does is to turn the arrow on its horizontal axis.)

Now let's take select and use several of its features. First, we will draw the outline of a Mac and its screen. Then, using Trace Edges, we'll give it some shape. Then we'll make a copy of it and rotate it. There you have it. One Mac ready for work and another one in the rest position.
Drag, Copy, Stretch and Look Strange

A simple way to duplicate figures is to use the select or lasso options with the command or option keys. For example, by placing the lasso around a figure, holding down the option key first and then dragging the figure, you will get duplicate copies. To stretch a figure, surround the figure with select, press the option key and drag the figure.

To get an interesting effect and multiple copies, lasso a figure, hold down both the option and command keys and drag the figure. Use this technique with letters, and you can create big bold block characters. The following figure starts with a brick chimney and then, using select and the option key, drags it to stretch it. Then, using the lasso and holding both the option and command keys, drags multiple overlapping copies. Using the lasso and only the option key, dragging creates multiple copies each time the button is released.
The techniques discussed above are useful for making objects appear as three dimensional ones. First, draw your figure and lasso it. Then, hold down the option key and drag your figure partially off the original one and release the keys and button. You now have two overlapping figures. By placing lines in strategic places and using shading, three-dimensional figures are quite simple to create.

Give Me a Hand

So far we've been discussing only a partial page of graphics, the area we have called our canvas window. When you print your graphics to a printer, you will be using a larger area than what is seen on the canvas. To use the entire page, we have to move our canvas around the various parts of the page. In order for everything to look right, we have to see the whole page first. This is especially true if we are attempting to create a picture that will fill in the entire page on our printer.
First, draw a horizontal line from one side of your canvas to the other, and then draw a vertical line from top to bottom of your canvas. Next, take the pointer and place it on the hand icon (located directly next to the letter A) and click it twice. (You can also choose Show Page from the Goodies Menu.) Your disk will whirr for a second and then you will see your lines superimposed on a white background. The white area represents the area of a full printer page. The window around your drawing is the canvas window. It shows you where your drawing area is relative to the page.

Now take the pointer and place it inside the window. Hold down the mouse button and move the window around the page. When you release the button, the canvas window will stop moving. If you return to the drawing window, that portion of the page where you left the window will be shown on the screen.

Next, place the pointer outside the window and hold down the button and move the mouse. This time, instead of the window moving, the figure moves. You can place it anywhere you want on the page. This will allow you to put your drawing where you want it on the page. Now, choose Cancel and go back to the drawing canvas.

Choose the hand icon, and place it on the screen. Press and hold the mouse button and move the mouse. The figure appears to be moving around the screen, but you are actually moving the figure around the page. If you place the hand pointer at the bottom of the screen, hold the button and push upwards, you can move the figure right off the screen. Go ahead and do it.

Now go back and bring up the whole page again. (Double click on the hand icon with the pointer.) You will see your figure above the drawing window when the full page is shown. Use the hand tool when you want to move figures around the page. When you want to move things around the canvas, use the lasso or select tools.
The final feature of MacPaint is its text printing capabilities. To access text, you click the letter A icon located directly to the right of the hand. First, it is important to note that the text feature of MacPaint does not work like a word processor. It has none of the editing, word wrap and other features of a word processor. The primary function of text in MacPaint is to label graphics and create graphic enhanced headers. You have a choice of nine fonts, eight font sizes, six styles and three alignments. The six styles can be used singly or in conjunction with one another. The combinations you can create are enormous. (Use your computer to figure it out.) The following shows you all nine fonts created in 18 point size on the left column, and the six styles, separately and combined, in the font in the right column.

<table>
<thead>
<tr>
<th>New York</th>
<th>Plain text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geneva</td>
<td>Bold</td>
</tr>
<tr>
<td>Toronto</td>
<td>Italic</td>
</tr>
<tr>
<td>Monaco</td>
<td>Underline</td>
</tr>
<tr>
<td>Chicago</td>
<td>Outline</td>
</tr>
<tr>
<td>Venice</td>
<td>Shadow</td>
</tr>
<tr>
<td>London</td>
<td></td>
</tr>
<tr>
<td>Athens</td>
<td>Combined Styles</td>
</tr>
<tr>
<td>San Francisco</td>
<td></td>
</tr>
</tbody>
</table>
While in MacPaint, text is treated exactly like anything else you would place on the canvas. You can work with it like exactly like you would anything else you drew on the screen. If you plan on incorporating your drawings into your word processing file, be sure to use complimentary or matching fonts. However, even thought you can incorporate graphics into word processing files, you cannot use the word processor to closely label your graphics. Therefore, before you incorporate a graphics file into MacWrite, be sure to take care of all your text work around your graphics.

Using the text with graphics is very simple and fairly self-explanatory. However, there are a couple of tricks. First, if you want to use multiple fonts and/or styles, after you have finished writing in one font/style, press the Enter key. This will “lock” your text in the current font/style. Then, you can make font/style and size changes without affecting the current one. However, if you want to write some text and then test the appearances of several fonts, styles and sizes, do not press Enter. It’s all right to press Return, though.

A second trick is in setting up columns and margins. When you move the I-beam cursor and press the mouse button, that point becomes your margin. When you finish typing a line of text and press Return, the cursor position will be down one line but will use the same margin you set when you hit the mouse button. To make double columns, just click in the left margin and write your lines of text for the first column. When you’re finished with the first column, move the I-beam cursor to the top of the second column, click the mouse button and write in the second column.

Summary

MacPaint is so easy to use you will be able to pick it up very quickly. This chapter was intended to pass on some tricks I found and to further your enjoyment of this powerful application. It is sometimes difficult to make the connection between
drawing on a screen and printing the results on paper. Since MacPaint uses a white background on which to write, this problem is minimized. Using the full page view of your graphics, not only can you see where your graphics will appear on your printed page, but you can move the picture to a more desirable position. Once you get used to manipulating the various tools, learning the special tricks and seeing the correspondence between what you draw and what you will see on your printer, MacPaint can turn your Macintosh into an artist’s studio.
Chapter 6

Word Processing with MacWrite

Getting Started

Like all other applications on the Mac, starting MacWrite is simple. From the desktop window, point to the MacWrite icon and give it a double click. Wait a few seconds, and you will be presented with an Untitled MacWrite window. The window is your writing area. As you first get your window, you will be given a ruler at the top of the screen. This has a set of formatting icons we will explain in a bit. Above the window and ruler are the MacWrite menus. We'll open them up so you will have an overview of what is in each. As we go along, we will refer to the menus when needed.

If you have used a word processor on another computer, it is important to understand that the Macintosh prints exactly what you see on the screen. The letters are proportionally spaced instead of monospaced as they are on most other word processor screens and computers. As we have pointed out elsewhere in this book, what you see is what you get.

MacWrite Menus

Let's see what the MacWrite Menus look like first. The Apple icon menu is the same as it always is except it has a little notice about MacWrite. We won't open it, but you can access any of the selections in that menu as well. The notepad is especially useful if in the middle of your work you wish to type a note to yourself. Similarly, if you want to do some numeric calculations, you can pull down the calculator. The other menus, though, are unique to the MacWrite application.
File | Edit | Search
---|---|---
New | *Can’t Undo | *Z | Find...
Open | Cut | *X | Change...
Close | Copy | *C |
Save | Paste | *V |
Save As... | Show Clipboard |
Page Setup |
Print... |
Quit |

*This choice will change depending on what last happened. Basically, it allows you change your mind about the last change you made. The other options that may appear include the following:

- Redo Typing
- Undo Cut
- Redo Cut
- Undo Paste
- Redo Paste
- Undo Copy
- Redo Copy

Format | Font | Style
---|---|---
Insert Rulers | New York | Plain Text | *P
Hide Rules | Geneva | Bold | *B
Show Header | Toronto | Italic | *I
Show Footer | Monaco | Underline | *U
Set Page #... | Chicago | Outline | *O
Insert Page Break | Venice | Shadow | *S
Title Page | London |
| Athens | 9 Point |
| San Francisco | 12 Point |
| | 14 Point |
| | 18 Point |
| | 24 Point
The fonts for MacPaint and MacWrite are the same. Take a look at the types and styles of fonts in Chapter 5 to get an overall view of what they look like. There are three fewer font sizes in MacWrite than in MacPaint. Otherwise, they are identical in style and type. However, changing fonts, styles and sizes in MacWrite is very different than in MacPaint. Therefore, if you have used MacPaint a good deal, you should pay close attention to the section in this chapter about changing fonts, font styles and sizes. You have more flexibility with MacWrite than with MacPaint, and it is a good deal easier to change fonts in the middle of your text with MacWrite. This is especially important for such tasks as italicizing and underlining text.

Setting Up Your Format

The first thing you will want to do is to set up your margins and tabs. The ruler at the top of your page will give you a clear idea of where the margins and tabs will be relative to your printed page. The default 12 point plain New York font will give you about 55 columns using full margins. Different types of fonts take up more or less space than the New York, and different styles of the same font will change the number of columns you can get in a single line. Of course, the font size you choose will also affect the number of characters you get per line.

Margin Settings

The solid black triangles on your ruler set your left and right margins. Take your pointer and drag your margin markers to the left or right. Right under your left margin marker is a little arrow-shaped marker. This is used to set the paragraph indentation. Whenever you press the Return key, your typing marker on your writing page will jump to the column set by your paragraph marker. Unlike using a typewriter, when you come to the end of a line, you do not have to hit the "carriage return." Your computer will automatically bring your text to the next line. Only when you are finished with a paragraph...
and want a paragraph indentation should you press the Return key. If you want block printing, place your left margin right on top of the paragraph marker.

Tab Settings

There are two sets of tab markers. These are the two hollow triangles on your ruler and the hollow triangle icon below your ruler. Set the two on your ruler simply by dragging them with your mouse. If you want more than two tab settings, just go to the tab icon and drag one from there and set it on your ruler. Whenever you press your Tab key, the writing pointer will jump to the next tab just as on a typewriter. The only difference between jumping tabs on a typewriter and in MacWrite is that on your computer, after jumping to the last tab, your Mac will jump to the first tab on the next line when the Tab key is pressed again.

Decimal Tab

There is a special tab on MacWrite you will use a good deal if your have to align numbers with decimal points. This is called the “decimal tab,” and it is set in the same way as the regular tabs. However, when you tab to the decimal tab position, all numeric entries with decimal points will line up on the decimal point. You have to be careful when you jump to a decimal tab setting not to enter straight text, since it also lines up on the decimal position. For example try the following:

1. Set the decimal tab under the 3 on the ruler.

2. Write in some regular text from the left margin or paragraph indentation and press Return.

3. Press the Tab key so that the writing marker is under the decimal tab and enter a number with decimal points and press Return. Do that several times so that you can see how numbers line up on the decimal tab.
4. Now, press Return and jump to the decimal tab and enter text with no numbers. Your text will start at the tab position and scroll to the left!

For the most part, when you use the decimal tab, make sure you need it. While it is a great help for lining up numbers in columns, it can get in the way of text. Further on in this chapter we will see how to use multiple rulers so that you can set only that part of your document for decimal tabs where you will need them.

**Vertical Spacing and Text Alignment**

To the right of the two tab icons on your ruler are seven other icons. The first three are for single, one and a half and double spacing your text, respectively. You choose your vertical spacing simply by pointing to the desired icon and clicking the mouse button. Whatever choice is active is indicated by the icon being inversed.
The last four icons on your ruler are for aligning your text. The default alignment is left justified in the same way a typewriter justifies text. It is all lined up evenly on the left side and ragged on the right. The second alignment icon is for center alignment. This is useful for making announcements and fliers. Every line is centered. The third alignment is right justified. This is the opposite of left justification, and it is used for special effects in documents. (To be honest, I never use it.) Finally, you can have your text aligned on both the right and left sides. This is the one I usually use for creating written documents. It gives a "printed" look to your work. Using it, your MacWrite works almost like a typesetting machine.

Once you get your margins, paragraph indentations and tabs set, practice writing some text. You will quickly see what happens with your margins and indentations, once you have a screenful of text. In fact, for the purpose of practice, copy a couple of these paragraphs to use for practice. Remember, whatever you create for practice can be thrown in the trash later on; so you might as well work on something you don't need, rather than on your opus.

Saving and Retrieving Your Text

Once you have finished writing a document, or part of it, you will want a permanent storage place for it. As soon as you turn off the power on your Mac, nothing is stored in the computer other than the clock's time. Only by writing to disk can you save something for later use.

Save and Save As . . .

When you're all finished with your document, up to 8½ pages of single spaced 12 point plain text, you can save the file to disk. There are two ways to do this.

1. Save text only

2. Save entire document
If you save the text only, you save some disk space since the only thing going to your disk is the text and none of the formatting information. If you don’t mind resetting the tabs and margins, and there are no multiple rulers, decimal tabs or other fancy formatting, it’s best just to save the text. However, if you have done a lot of formatting, then it is better to save your entire document. Not only can this be retrieved from MacWrite for editing, you don’t have to re-format everything again.

To start the save procedure, you can either click the upper left hand box of your writing window or choose Save or Save As... from the File Menu. You will then be presented with the following choice window:

If you are saving your document to another disk, choose Eject and go through the SAVE sequence with your other diskette in the drive. If it is a new document, then enter the file name from the keyboard. If you chose Save, either from the File Menu or by clicking the window box, and you already have a file name, either choose Save or Cancel with the mouse.
pointer. Also select saving the Entire Document or Text Only with the pointer. If you use Save As . . ., you can save an old document under a new name. This is very useful with form letters. You load the form letter into memory, make changes for the particular addressee, and then using Save As . . ., save the individual letter to disk. You will still have your original form letter unchanged on disk along with your "individualized" letter.

Retrieving Text

Retrieving text you have saved to disk can be done in two basic ways:

1. From the desktop
2. From MacWrite

To get back some text you have saved, simply double click the text icon from the desktop. If a document is saved as Text Only, this is the only way you can get it back. From MacWrite, close any work present, and choose Open from the File Menu. You will be then give the following window:
Using the pointer, click one of the file names in the window. Scroll the window using the pointers on the window arrows if necessary to see all the names. If the file is not on the current disk, choose Eject and place the disk in the drive with the correct file. If you choose Open, the file you picked will be loaded with its file name on the window bar at the top. The Open As... choice will give you an Untitled header name. This option is on the same basis as Save and Save As... You can work on the document and save it under a different file name while maintaining the original.

For most of your basic word processing, the above discussion will get you started. You should be able to load MacWrite, set tabs and margins, choose your font, font style and size and create, save and retrieve text. The rest of this chapter deals with editing your text and special tricks you can do with MacWrite.

**Editing With MacWrite**

The major difference between using a typewriter and a word processor is in a word processor's editing capabilities. We'll start with editing letters and words, then blocks and eventually moving things all over the place.

**Editing Letters and Words**

Let's suppose after you have written your document, you find a misspelled word. (In my documents, I find a few correctly spelled words.) Using the mouse, move the I-beam shaped cursor to the right of the error and click the mouse button. Using the back space key, back over and erase the incorrect letters and key in the new ones. Alternatively, you can insert letters at the point you placed the I-beam. That's all there is to it! Your correction is now made, and as soon as you re-SAVE your document to disk, it will have the correction in place.
Another problem I encounter is misspelling the same word several times. For example, let's say you have written "mose" when you meant to write "mouse." Now you could go through and find each place you incorrectly put in "mose" for "mouse" and backspace and insert the correct spelling. However, there's an easier way. You use the Search Menu. Here's what you do:

**Change**

1. Select Change ... from the Search Menu. You will see the following Change window:

![Change window](image)

2. In the Find what portion of the window, enter the word "mose."

3. Place the pointer in the Change to box and click it. Enter the word mouse in the Change to box.

4. Place the pointer in the Find Next box and click it. (If you are certain there are no instances of mose that should not be mouse you can select Change All.)
5. Click the button in the Find Next box and the next instance of mose will be inversed on your text. At this point you have the option of going on to the next instance of mose, (Find Next), changing mose to mouse and then going on to the next instance of mose (Change, then Find) or simply changing mose to mouse (Change). If you select Change All at this point you will be given a WARNING!

When all of the instances of the word you are changing have been found, a window announcing,

"mose" not found

will appear, and you just click the OK at the bottom of the window. Then click the "close box" at the top of the Change window.

Find

The other item in the Search Menu, “Find . . . ” works in a manner almost identical to “Change . . . ” except you just have the “Find Next” option. Nothing is changed in your document. If you have a long document, rather then using the scrolling arrows and box on the right side of the text writing window, you can use find to jump to a key location. If you are inserting text into the middle of a long document and are planning on working on the document later, you can flag your place in the document with some special symbol. For example, the Option-S figure is one I have never used in documents. When I stop in the middle of a document, I just key in a couple Option-S figures. Then, when I resume work on the document, I just use the Find function to locate the double Option-S flag. Of course, you have to remember to remove your flags when you’re done.
Block Editing: Cutting, Copying and Pasting

Sometimes you find an entire paragraph needs to be moved from one place to another, deleted altogether or some major section of your document needs to be duplicated. This is a piece of cake with MacWrite. It involves selecting the block you want moved, copied or deleted and then using Cut or Copy and Paste. You use the following procedure for block work:

1. Select a block of text by holding down the mouse button and dragging the I-beam pointer down the left margin or across the text you want selected for block operations. It will be inversed when "activated."

2. Open the Edit Menu and select either Cut or Copy. (You can also use Command-X or Command-C.) Whatever you cut or copy will be placed on the Clipboard. If you select Cut, the text will be removed from the screen.

3. Move the pointer to the portion of your document where you want to insert the block and click the mouse button.

4. Go back to the Edit Menu and choose Paste. (You can save time by just pressing the Command and V keys.) That will put the material stored on the Clipboard on the screen where you last clicked the pointer.

If you Cut or Copy material and then Paste it on the screen, that material still stays on the Clipboard. Whenever you Cut or Copy something new, it will be transferred to the Clipboard and whatever was there before is removed. Just remember that the last Cut or Copy will be the contents of the Clipboard.

Merging Text

There will be some cases where you will want to merge files. For example, let's say that you have two parts of a report and you want them together on the same file. This will allow you to
more easily edit and work with the entire report. All merging files involves is moving one file to the Clipboard and then pasting the contents of the Clipboard onto the other file. Use the following steps:

1. Load the second file into MacWrite. Using the mouse, select the entire document by dragging the I-beam pointer down the left margin of the text. (You can save time by single spacing a document before doing this.)

2. Cut the document and close it without saving the changes.

3. Load the first file into MacWrite and put the pointer at the end of the text and click the mouse button.

4. Press Command-V or select Paste from the Edit menu. The contents of both files are now in memory.

5. Save the document, either under a new file name or under the old file name of the first document. Your two files are now one.

Sometimes when you have a big chunk of a file in memory and try to load another file, you will be informed that there is not enough memory space available. That means between the MacWrite application program and your file and clipboard, you have exceeded the 128K RAM. When you want to merge files under these conditions, the merger has to take place on your printer. Basically, what you do is to print out the first half of your document from one file, and then just print the next part or parts of the document from other files. By writing each file so that the file ends at a page break, your files can be printed out in a single continuous document. Each time a file has been printed, simply check the last page number printed, and then from the Format Menu, set the page number to the next page. For example, if the last page number of a file printed is 5, set the first page number of the next file at 6. This will allow you to merge as many files as you want on your printer.
Merging Text and Graphics

Merging Text from MacWrite with graphics from MacPaint uses the same procedure as merging text. You simply load the MacPaint picture onto the screen, and, using the Select icon, Cut or Copy it onto the Clipboard. Then quit MacPaint and load the MacWrite document. Place the pointer in the position you wish to merge the graphic, click the mouse, and paste the picture. Remember, MacWrite doesn’t care whether graphics or text is on the Clipboard. Whatever is there will be pasted into place when Paste is selected.

Using Multiple Rulers

When you are making columns of text or numbers, you need special formatting, but for the most part, one or two tabs is all you will need in most of your documents. When you have several tabs, especially decimal tabs, the tabs tend to be more of a hindrance than a help for standard text entry. In order to have all the tabs you need when you need them and to get them out of the way when you do not need them, MacWrite allows you to have multiple rulers. Each ruler sets the tabs for the material from the ruler to the next ruler. Therefore, you can set the tabs for a chart or columnized words or numbers and then another set of tabs for the rest of your documents.

For example, let’s say that you have document that needs a chart of numbers, a chart of text and the rest is simply expository writing.

EXPOSITORY TEXT
NUMERIC COLUMNS
TEXT COLUMNS
EXPOSITORY TEXT
With MacWrite, you would want the following arrangement:

```
RULER 1 : EXPOSITORY TEXT
RULER 2 : NUMERIC COLUMNS
RULER 3 : TEXT COLUMNS
RULER 1 : EXPOSITORY TEXT
```

This type of tab setting gives you the correct tabs when you need them and removes them when you do not. Using our above example, the following shows you how to set up and use multiple rulers.

1. Set the first rulers to the desired tabs and enter your text.

2. At the point you wish to enter your numeric columns, select Insert Ruler from the Format menu. Set the decimal tabs on the ruler and enter your columns of numbers.

3. When your are finished entering your numbers, select another Insert Ruler and set up the text tabs you wish for your text columns and enter them.

4. Finally, when you are finished with the text columns, insert another ruler and set the tabs to the same positions you had in your first ruler.

You can use as many rulers as you wish. If you have difficulty getting an idea of how everything looks with all those rulers on the screen, simply select Hide Rulers from the Format menu. You can also store a ruler on the Clipboard with Cut or Copy. This would be a good idea where you have a single main ruler you have to re-insert after you have made charts and tables with special rulers. You just Paste the ruler in whenever you are ready to use it again.
Inserting Page Breaks

Sometimes you will want to put a page break where one would normally not be placed. For example, suppose you are finishing the end of a chapter, and you want the beginning of the next chapter to start at the top of the next page. For MacWrite, this is simple. Just place the pointer to the location where you want the page to end and click the mouse. Then choose Insert Page Break from the Format menu. Your page break will be inserted where you last clicked the pointer.

Headers and Footers

A final feature of MacWrite is the use of headers and footers. These are used for setting the margins at the top and bottom of each page and any messages you want there. In addition, with your Mac, you can automatically time and date your document. This is handy for keeping track of multiple drafts of a work. You can see at a glance from your printout when you last worked on a given copy.

Setting Top and Bottom Margins

From the Format menu, select Show Header or Show Footer. When the Header/Footer window appears you will see a ruler and three icons above the rules. Below the ruler is a cursor bar which can be moved down with the Return key or up with Backspace. The placement of the cursor will determine how many spaces will be at the top or bottom of the page. We will use three spaces, so press the Return key three times.

If you want a message at the top or bottom of your page, key in the message from the keyboard. Put in your name or the name of the document. If you want, you can even put in several lines of text, such as your company name, department and project name. You might want your name in the header (at the top of each page) and the name of the document in the footer (at the bottom of each page.)
Placing the Page Number, Date and Time

Next, the icon with the hatch mark (#) represents the page number. Drag the page number icon to the place you want the page number to appear at the top or bottom of your page. If you want the date in your footer or header, drag the calendar icon to the position you want the date to appear. Finally, the clock icon will record the time of the most recent printout. Be careful where you place the calendar and clock since the calendar includes the full spelling of the day, date, month and year as:

Thursday, 05 September, 1985

If the clock and calendar are too near, they will overlap. Of course, all you have to do is to check your document on the screen to see if the placement of the calendar overlaps with anything. If it does, just move it.

Summary

The simplicity and power of MacWrite serve as a summary of the Macintosh computer. Using the mouse and keyboard, the menu, icon and Command-key operations of MacWrite make it a very simple word processor to operate. At the same time, it can do far more than most word processors or computers. It has the ability to show you on the screen exactly what will appear on paper — not a reverse order of print and paper but an exact representation. Your word processor is very close to being a typesetting machine. With the use of multiple fonts, styles and font sizes, you can produce high quality printing that up to now has only been available from a professional printer.
The Apple Macintosh Primer

There are two reasons to buy this book:

1. You own an Apple Macintosh and want to learn how to use it in the simplest way possible.
2. You're thinking of buying a computer but aren't sure of what kind to buy.

THE APPLE MACINTOSH PRIMER will teach you all about the Mac — how it works, what it does, and why it may be just the computer for you!

You'll learn the Macintosh concept, what a mouse does, the keyboard layout, and how to set up the system. In no time at all you'll be an expert at using Mac's menus, saving and loading files, and using your new found knowledge in business, school and home applications.

THE APPLE MACINTOSH PRIMER also includes two special chapters on graphics with MacPaint and word processing with MacWrite. And best of all, everything is written in easy-to-understand language.

So whether you're a first time computer owner or an old pro with the Apple II+, //e, or ///, this is the book for you!